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Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF 
document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted.
Match Case finds only words that contain exactly the same capitalization you enter in 
the box.
Find Backwards starts the search from the current page and goes backwards through 
the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.
       To find the next occurrence of the word: 
        Do one of the following:
        Choose Edit > Find Again 
        Reopen the find dialog box, and click Find Again.  (The word must already be in the         
Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:
1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to the last 
letter.  
       To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or 
Option (Mac OS) as you drag across the width of the document. 
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       To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or 
Option+Command (Mac OS) as you drag the length of the document.
        To  select all the text on the page, choose Edit > Select All.  In single page mode, all the 
text on the current page is selected.  In Continuous or Continuous – facing mode, most of the 
text in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.  

2. Choose Edit > Copy to copy the selected text to the clipboard.
3. To view the text, choose Window > Show Clipboard
In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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1 [REPORT OF ACTION TAKEN IN CLOSED SESSION,

2 WEDNESDAY, NOVEMBER 12, 2003, BEGINS ON PAGE 73.]

3

4 There is no reportable action as a result of the Board of 

5 Supervisors' closed session held today.

6

7

8

9 SUP. BURKE, CHAIR: WOULD YOU PLEASE STAND? THE INVOCATION THIS 

10 MORNING WILL BE LED BY PASTOR LARRY JAMESON, FROM DOWNEY 

11 AVENUE FOURSQUARE CHURCH FROM PARAMOUNT, THE FOURTH DISTRICT. 

12 THE PLEDGE OF ALLEGIANCE WILL BE LED BY IRVING GABLE, TRUSTEE, 

13 SAN FERNANDO VALLEY POST NUMBER 603, JEWISH WAR VETERANS OF 

14 THE UNITED STATES, THE THIRD DISTRICT. PASTOR. 

15

16 PASTOR LARRY JAMESON: WE BOW IN PRAYER. LORD GOD ALMIGHTY, WE 

17 ARE SO GRATEFUL FOR ALL YOU HAVE DONE FOR THIS GREAT COUNTY OF 

18 LOS ANGELES. WE THANK YOU FOR YOUR OVERSIGHT, GUIDANCE, AND 

19 STRENGTH YOU BRING TO US EACH DAY. TODAY IS A NEW DAY, A DAY 

20 FILLED WITH CHALLENGES BUT AS WELL A DAY FILLED WITH HOPE, FOR 

21 YOUR PRESENCE IS WITH US. WE ASK TODAY YOUR BLESSING UPON THIS 

22 COUNTY AND EACH INDIVIDUAL WHO LIVES WITHIN ITS BOUNDARIES. 

23 PEOPLE NEED HOPE FOR THE FUTURE, SO I WOULD ASK THAT THROUGH 

24 THE DISCUSSIONS TODAY, THAT GREAT THINGS WOULD BE 

25 ACCOMPLISHED. MAY YOUR STRENGTH AND YOUR WISDOM BE UPON OUR 
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1 SUPERVISORS TODAY AS THEY ENDEAVOR TO PURSUE PEACE AND 

2 PROSPERITY FOR ALL PEOPLE OF THIS GREAT COUNTY. WE ASK THESE 

3 THINGS IN THE NAME OF GOD ALMIGHTY. AMEN. 

4

5 IRVING GABLE: FACE THE FLAG, PUT YOUR RIGHT HAND OVER YOUR 

6 HEART, AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. [ PLEDGE OF 

7 ALLEGIANCE ] 

8

9 IRVING GABLE: DOWN. 

10

11 SUP. BURKE, CHAIR: SUPERVISOR KNABE? 

12

13 SUP. KNABE: YES. THANK YOU, MADAM CHAIR AND MEMBERS OF THE 

14 BOARD. IT'S MY PRIVILEGE TO THANK AND PRESENT PASTOR LARRY 

15 JAMESON WITH THIS CERTIFICATE OF APPRECIATION. WE APPRECIATE 

16 VERY MUCH HIM TAKING TIME OUT OF HIS VERY BUSY SCHEDULE TO BE 

17 WITH US TODAY. PASTOR JAMESON HAS BEEN WITH THE DOWNEY AVENUE 

18 FOURSQUARE CHURCH FOR 17 YEARS. HE AND HIS WIFE DEBRA WHO IS 

19 ALSO A PASTOR AT THE CHURCH, LIVE IN DOWNEY AND ARE VERY 

20 ACTIVE AS WELL IN THE PARAMOUNT COMMUNITY. HIS CHURCH SENDS 

21 OUT 'WELCOME TO PARAMOUNT' PACKETS TO ALL NEW PARAMOUNT 

22 RESIDENTS AND PASTOR JAMESON HELPS TO OVERSEE THE FOURSQUARE 

23 CHURCHES IN THE AREA. SO WE REALLY APPRECIATE IT AGAIN, HIS 

24 KIND INVOCATION AND TAKING THE TIME TO LEAD US THIS MORNING. 

25 THANK YOU VERY MUCH. [ APPLAUSE ] 
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1

2 SUP. YAROSLAVSKY: MADAM CHAIR, WE WERE LED IN THE PLEDGE OF 

3 ALLEGIANCE THIS MORNING BY IRVING GABLE. MR. GABLE LIVES IN 

4 SHERMAN OAKS. HE'S REPRESENTING THE SAN FERNANDO VALLEY POST 

5 603, THE JEWISH WAR VETERANS OF THE UNITED STATES. HE SERVED 

6 IN THE UNITED STATES ARMY AIR FORCE FROM 1942 TO '46, IN THE 

7 TECHNICAL COMMAND, THE THIRD AIR FORCE. HE RECEIVED THE GOOD 

8 CONDUCT MEDAL, WORLD WAR II VICTORY MEDAL, NATIONAL DEFENSE 

9 SERVICE MEDAL. HE'S A RETIRED TEACHER AND COUNSELOR FOR THE 

10 L.A. UNIFIED SCHOOL DISTRICT. HAS LIVED 50 YEARS IN OUR 

11 DISTRICT. ORIGINALLY HAILS FROM NEW YORK, FROM COMMERCE HIGH 

12 SCHOOL IN NEW YORK, AND ATTENDED THE UNIVERSITY OF SOUTHERN 

13 CALIFORNIA. I WON'T HOLD THAT AGAINST YOU. AND CAL STATE L.A. 

14 IRVING, THANK YOU VERY MUCH FOR LEADING US IN THE PLEDGE AND 

15 THANK YOU FOR YOUR SERVICE TO OUR COUNTRY. [ APPLAUSE ] 

16

17 SUP. BURKE, CHAIR: WE'LL START THE AGENDA. 

18

19 CLERK VARONA-LUKENS: THANK YOU, MADAM CHAIR AND MEMBERS OF THE 

20 BOARD. MADAM CHAIR, COULD I PLEASE ASK MR. HOLLOWAY, IN THE 

21 FUTURE, IF HE WOULD GIVE US HIS HOLD SLIPS BEFORE THE BOARD 

22 MEETING STARTS. THERE MUST BE 20 HOLDS HERE. 

23

24 MERRITT HOLLOWAY: [ INAUDIBLE ]. 

25
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1 CLERK VARONA-LUKENS: ALL RIGHT -- 

2

3 SUP. BURKE, CHAIR: ALL RIGHT, WE'LL HANDLE THIS -- WE'LL TAKE 

4 CARE OF THE WAY THAT HE'S DOING IT. WE'LL DO IT ALL, BECAUSE 

5 HE DOES ALL OF IT AT ONE TIME, SO WE'LL JUST ADD ALL OF THEM 

6 AT THE FIRST ONE. 

7

8 CLERK VARONA-LUKENS: OKAY. WE'LL BEGIN ON PAGE 3. ON ITEM S-1, 

9 THE DIRECTOR REQUESTS A ONE-WEEK CONTINUANCE. 

10

11 SUP. BURKE, CHAIR: WITHOUT OBJECTION, S-1 IS CONTINUED FOR ONE 

12 WEEK. 

13

14 CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE COMMUNITY 

15 DEVELOPMENT COMMISSION, ITEM 1-D. 

16

17 SUP. BURKE, CHAIR: MOVED BY MOLINA, I'M SORRY. MOVED BY 

18 ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

19

20 CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE HOUSING 

21 AUTHORITY, ITEM 1-H. 

22

23 SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY KNABE. 

24 WITHOUT OBJECTION, SO ORDERED. 

25
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1 CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE REGIONAL 

2 PARK AND OPEN SPACE DISTRICT, ITEM 1-P. 

3

4 SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY ANTONOVICH. 

5 WITHOUT OBJECTION, SO ORDERED. 

6

7 CLERK VARONA-LUKENS: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 15, 

8 I HAVE THE FOLLOWING REQUEST. ON ITEM NUMBER 3, HOLD FOR 

9 GENEVIEVE CLAVREUL. ON ITEM NUMBER 5, HOLD FOR MERRITT 

10 HOLLOWAY. ON ITEM NUMBER 7, SUPERVISOR ANTONOVICH REQUEST A 

11 ONE-WEEK CONTINUANCE, AND SUPERVISOR YAROSLAVSKY REQUEST A 

12 ONE-WEEK CONTINUANCE AS WELL WITH A REQUEST FOR COUNTY COUNSEL 

13 TO PROVIDE A REPORT. 

14

15 SUP. BURKE, CHAIR: ALL RIGHT. WITHOUT OBJECTION, ITEM 7 IS 

16 CONTINUED FOR ONE WEEK. AND THE COUNTY COUNSEL'S TO REPORT ON 

17 THAT. 

18

19 CLERK VARONA-LUKENS: ON ITEM NUMBER 8, HOLD FOR SUPERVISOR 

20 ANTONOVICH AND OTHER. ON ITEM NUMBER 9, HOLD FOR MERRITT 

21 HOLLOWAY. 

22

23 SUP. BURKE, CHAIR: WELL WE'LL HOLD THAT UNDER 5. 

24
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1 CLERK VARONA-LUKENS: ALSO, ON ITEM NUMBER 10, HOLD FOR MERRITT 

2 HOLLOWAY. 

3

4 SUP. BURKE, CHAIR: ALSO UNDER 5. 

5

6 CLERK VARONA-LUKENS: ON ITEM NUMBER 11, HOLD FOR MERRITT 

7 HOLLOWAY. ON ITEM NUMBER 12, HOLD FOR MERRITT HOLLOWAY. AND 

8 THE REST ARE BEFORE YOU. 

9

10 SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY ANTONOVICH, 

11 SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

12

13 CLERK VARONA-LUKENS: ADMINISTRATIVE OFFICER, ITEMS 16 AND 17. 

14 ON ITEM NUMBER 16, HOLD FOR MERRITT HOLLOWAY. AND ITEM 17 IS 

15 BEFORE YOU. 

16

17 SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY KNABE. 

18 WITHOUT OBJECTION, SO ORDERED. 

19

20 CLERK VARONA-LUKENS: BEACHES AND HARBORS, ITEM 18. SUPERVISOR 

21 ANTONOVICH REQUESTS A ONE-WEEK CONTINUANCE -- I'M SORRY. 

22 SUPERVISOR KNABE REQUEST A ONE-WEEK CONTINUANCE, AND 

23 SUPERVISOR ANTONOVICH AND MERRITT HOLLOWAY REQUEST THAT THE 

24 ITEM BE HELD. 

25
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1 SUP. BURKE, CHAIR: SUPERVISOR -- HUH? 

2

3 SUP. ANTONOVICH: CONTINUE IS FINE. 

4

5 SUP. BURKE, CHAIR: OKAY, WITHOUT OBJECTION, ITEM 18 WILL BE 

6 CONTINUED FOR ONE WEEK. 

7

8 CLERK VARONA-LUKENS: ON ITEM NUMBER 19, CHILD SUPPORT 

9 SERVICES, HOLD FOR MERRITT HOLLOWAY. CHILDREN AND FAMILY 

10 SERVICES, ITEM 20, HOLD FOR SUPERVISOR KNABE AND OTHERS. ON 

11 ITEM 21, CONSUMER AFFAIRS, HOLD FOR MERRITT HOLLOWAY. FIRE 

12 DEPARTMENT, ITEM 22, HOLD FOR SUPERVISOR MOLINA AND OTHERS. 

13

14 CLERK VARONA-LUKENS: HEALTH SERVICES, ITEMS 23 THROUGH 26. ON 

15 ITEM NUMBER 24, HOLD FOR GENEVIEVE CLAVREUL AND ON ITEM 25, 

16 HOLD FOR MERRITT HOLLOWAY. 

17

18 SUP. BURKE, CHAIR: ALL RIGHT. ON 3 AND 24, WE'LL TAKE THOSE 

19 BOTH TOGETHER. 

20

21 CLERK VARONA-LUKENS: OKAY AND THE REST ARE BEFORE YOU. 

22

23 SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY KNABE, SECONDED 

24 BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

25
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1 CLERK VARONA-LUKENS: MENTAL HEALTH, 27 AND 28. 

2

3 SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY 

4 ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

5

6 CLERK VARONA-LUKENS: PROBATION, ITEMS 29 AND 30. 

7

8 SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. 

9 WITHOUT OBJECTION, SO ORDERED. 

10

11 CLERK VARONA-LUKENS: PUBLIC WORKS, ITEMS 31 THROUGH 45. ON 

12 ITEM NUMBER 34, THE DIRECTOR OF PUBLIC WORKS REQUEST A ONE-

13 WEEK CONTINUANCE. ON ITEM 35, HOLD FOR MERRITT HOLLOWAY. ON 

14 ITEM 36, HOLD FOR MERRITT HOLLOWAY. AND ON ITEM 38, HOLD FOR 

15 MERRITT HOLLOWAY. ON ITEM 39, HOLD FOR MERRITT HOLLOWAY. AND 

16 THE REST ARE BEFORE YOU. 

17

18 SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY KNABE, SECONDED 

19 BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

20

21 CLERK VARONA-LUKENS: SHERIFF, ITEMS 46 AND 47. 

22

23 SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY 

24 YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

25
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1 CLERK VARONA-LUKENS: ORDINANCE FOR INTRODUCTION, ITEM 48, IS 

2 AN ORDINANCE EXTENDING THROUGH DECEMBER 31, 2005, A FRANCHISE 

3 TO PROVIDE CABLE TELEVISION SERVICE IN THE WALNUT PARK 

4 UNINCORPORATED AREA, GRANTED TO ADELPHIA COMMUNICATIONS 

5 CORPORATION, A DELAWARE CORPORATION. AND WE NEED TO HOLD THAT 

6 ITEM. IT RELATES TO AGENDA 21. THAT WAS A HOLD BY MERRITT 

7 HOLLOWAY. 

8

9 SUP. BURKE, CHAIR: AND NO ONE ELSE. RIGHT? 

10

11 CLERK VARONA-LUKENS: RIGHT. ORDINANCES FOR ADOPTION. ON ITEM 

12 49, HOLD FOR MERRITT HOLLOWAY. ON ITEM 50, HOLD FOR MERRITT 

13 HOLLOWAY. ON ITEM 52, HOLD FOR MERRITT HOLLOWAY. AND ON ITEM 

14 53, HOLD FOR MERRITT HOLLOWAY. THE REST ARE BEFORE YOU. 

15

16 SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY YAROSLAVSKY. 

17 WITHOUT OBJECTION, SO ORDERED. 

18

19 CLERK VARONA-LUKENS: PUBLIC HEARING, ON ITEM 55, HOLD FOR 

20 HEARING. 56, ADDITIONS TO THE AGENDA -- [ MUSIC ] 

21

22 CLERK VARONA-LUKENS: -- REQUESTED BY BOARD MEMBERS AND THE 

23 CHIEF ADMINISTRATIVE OFFICER WHICH WERE POSTED MORE THAN 72 

24 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE GREEN 

25 SUPPLEMENTAL AGENDA. 56-A. 
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1

2 SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY 

3 YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

4

5 CLERK VARONA-LUKENS: ON ITEM 56-B, HOLD FOR SUPERVISOR KNABE 

6 AND OTHERS. 56-C. 

7

8 SUP. BURKE, CHAIR: MOVED BY ANTONOVICH, SECONDED BY KNABE. 

9 WITHOUT OBJECTION, SO ORDERED. 

10

11 CLERK VARONA-LUKENS: 56-D. 

12

13 SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY YAROSLAVSKY. 

14 WITHOUT OBJECTION, SO ORDERED. 

15

16 CLERK VARONA-LUKENS: AND THAT COMPLETES THE READING OF THE 

17 AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH 

18 SUPERVISORIAL DISTRICT NUMBER 5. 

19

20 SUP. BURKE, CHAIR: WHAT I'LL DO IS THAT I'LL GO ON AND START 

21 UNTIL HE'S OFF THE PHONE. [ INDISTINCT VOICES ] 

22

23 SUP. BURKE, CHAIR: I'D LIKE TO CALL FIRE CHIEF FREEMAN AND 

24 REPRESENTATIVES OF LOCAL 1014 AND THE MUSCULAR DYSTROPHY 

25 ASSOCIATION FORWARD. OKAY. WE'LL GO TO THE NEXT ONE. OKAY. 
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1 THEY'RE HERE. THE MUSCULAR DYSTROPHY ASSOCIATION AND 

2 INTERNATIONAL ASSOCIATION OF FIRE FIGHTERS HAVE A PARTNERSHIP 

3 THAT SPANNED 50 YEARS. DURING THAT TIME, THE INTERNATIONAL 

4 ASSOCIATION AND ITS MEMBER FIRE DEPARTMENTS HAVE RAISED AND 

5 DONATED MORE THAN $200 MILLION TO THE MUSCULAR DYSTROPHY 

6 ASSOCIATION, OR M.D.A. MOST RECENTLY, THE LOS ANGELES COUNTY 

7 FIRE DEPARTMENT LOCAL 1014 ENGAGED IN A 'FILL THE BOOT' 

8 FUNDRAISER CAMPAIGN FROM JULY 21ST TO 23RD THAT DONATED MORE 

9 THAN $250,000 IN SUPPORT OF THE M.D.A.'S MANY PROGRAMS. IN 

10 HONOR OF OUR LOCAL FIRE FIGHTERS, THE M.D.A. IS SPONSORING 

11 NOVEMBER 17TH THROUGH THE 23RD AS M.D.A. FIRE FIGHTING 

12 APPRECIATION WEEK, AND THE COUNTY OF LOS ANGELES HEREBY JOINS 

13 IN PROCLAIMING NOVEMBER 17TH THROUGH THE 23RD AS MUSCULAR 

14 DYSTROPHY ASSOCIATION/FIRE FIGHTERS APPRECIATION WEEK 

15 THROUGHOUT THE COUNTY. I'D LIKE TO ASK KERRY WALTER, DISTRICT 

16 DIRECTOR OF M.D.A. LOS ANGELES WHO IS ACCOMPANIED BY 

17 CALIFORNIA GOODWILL AMBASSADOR, ALEX VIA, CHIEF MICHAEL 

18 FREEMAN, AND DAVE GILOTTE, PRESIDENT OF LOCAL 1014 AND 

19 ENGINEER WITH THE L.A. FIRE DEPARTMENT TO COME FORWARD. GOOD 

20 MORNING. HOW ARE YOU? YOU'RE HERE FOR CHIEF FREEMAN, WE HAVE 

21 ERIC WEBBER. CHIEF WEBBER? [ INDISTINCT VOICES ] 

22

23 SUP. BURKE, CHAIR: OKAY, ARE YOU GOING TO COME IN? 

24

25 SPEAKER: YES, ABSOLUTELY. 
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1

2 SUP. BURKE, CHAIR: DO YOU WANT TO ACCEPT THIS FOR HIM? WELL 

3 HERE WE GO. [ INDISTINCT VOICES ] 

4

5 SUP. BURKE, CHAIR: OKAY. AND LOCAL 1014 IS -- 

6

7 SPEAKER: UNFORTUNATELY THEY WERE NOT ABLE TO BE HERE. 

8

9 SUP. BURKE, CHAIR: AND MICHAEL FREEMAN IS UNABLE TO BE HERE. 

10

11 SPEAKER: I'LL BE DELIVERING. 

12

13 SUP. BURKE, CHAIR: OKAY, WHO'S GOING TO SPEAK? ALL RIGHT GOOD. 

14 ERIC CAN YOU SPEAK ALSO? 

15

16 SPEAKER: WELL ON BEHALF OF CHIEF FREEMAN AND ALL THE MEN AND 

17 WOMEN OF THE FIRE DEPARTMENT WE CERTAINLY APPRECIATE THIS 

18 RECOGNITION. THE FIREFIGHTERS DO A TERRIFIC JOB WITH M.D.A. 

19 AND I BELIEVE THIS YEAR THEY SET AN ALL-TIME RECORD IN TERMS 

20 OF THE MONEY COLLECTED, SO THANK YOU, SUPERVISOR FOR 

21 RECOGNIZING THEM. 

22

23 SUP. BURKE, CHAIR: THANK YOU. THANK YOU. [ APPLAUSE ] 

24
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1 SUP. BURKE, CHAIR: OKAY, ALL RIGHT. SUPERVISOR ANTONOVICH, DO 

2 YOU WANT TO DO YOUR -- OR WERE YOU GOING TO SAY SOMETHING? [ 

3 INDISTINCT VOICES ] 

4

5 SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH? 

6

7 SUP. ANTONOVICH: THIS MORNING, WE WOULD LIKE TO INTRODUCE THE 

8 PRESIDENT AND THE C.E.O. OF NATTEL ENGINEERING COMPANY AND, 

9 WHICH IS A CHATSWORTH-BASED BUSINESS, WHICH HAS JUST BEEN 

10 AWARDED THE UNITED STATES SMALL BUSINESS ADMINISTRATION'S 

11 REGIONAL SMALL BUSINESS SUBCONTRACTOR OF THE YEAR 2003. SUDESH 

12 ARORA WHO IS THE PRESIDENT AND THE C.A.O. IS HERE WITH US. 

13 THIS WAS FOUNDED BY SUDESH IN 1975. NATELL IS A LEADER IN THE 

14 DESIGN DEVELOPMENT AND MANUFACTURING OF COMPLEX HIGH END 

15 ELECTRONIC AND MICROELECTRONICS CONVERSION PRODUCTS. IN 

16 ADDITION TO BEING HONORED AS A SUBCONTRACTOR OF THE YEARS 

17 SUDESH'S LEADERSHIP HAS ALSO LED TO NATELL BEING AWARDED THE 

18 RATHEON MICROELECTRONICS OUTSOURCE CONTRACTS, WHICH IS ONE OF 

19 THE LARGEST OUTSOURCE CONTRACTS AWARDED OVER THE LAST DECADE 

20 TO MICROELECTRONIC MANUFACTURING FIRMS. SUDESH OBTAINED HIS 

21 BACHELOR'S DEGREE WITH HONORS IN ELECTRICAL ENGINEERING FROM 

22 THE INDIAN INSTITUTE OF TECHNOLOGY AT BOMBAY AND HE WAS ONE OF 

23 A SELECT 5% AWARDED THE MERIT SCHOLARSHIP AND RECEIVING HIS 

24 MASTER'S DEGREE FROM CARNEGIE MELON COLLEGE. PRIOR TO FOUNDING 

25 NATELL HE WORKED FOR THE GOLF RESEARCH AND DEVELOPMENT COMPANY 
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1 WHERE HE DEVELOPED A SOPHISTICATED SOFTWARE ANALYZER WHICH WON 

2 THE COMPANY THE CONVERTED RR-100 AWARD FROM THE INDUSTRIAL 

3 RESEARCH MAGAZINE AND IS ONE OF THE 100 MOST SIGNIFICANT 

4 DEVELOPMENTS OF THE YEAR. HE IS JOINED THIS MORNING BY THE 

5 VICE -- BY JIM ANGELINI, WHO IS THE VICE PRESIDENT IN NATELL. 

6 SO NOW AT THIS TIME, SUDESH, WE WOULD LIKE TO GIVE YOU THIS 

7 PROCLAMATION AND WISH YOU CONTINUED SUCCESS AND ANOTHER GREAT 

8 25 YEARS OF GREAT PROGRESS. THANK YOU, HOW ARE YOU? [ APPLAUSE 

9 ] [ INDISTINCT VOICES ] 

10

11 JIM ANGELINI: WELL ON BEHALF OF SUDESH AND ALL THE EMPLOYEES 

12 OF NATELL, WE APPRECIATE THIS RECOGNITION AND WE'RE PROUD TO 

13 BE IN SUPPORT OF RAYTHEON WHO SUPPORTS OUR WAR FIGHTERS IN THE 

14 FIELD AND IN THESE DAYS, YOU KNOW, OUR FREEDOMS IN GENERAL 

15 WITH THE TECHNOLOGY THAT WE PROVIDE. THANK YOU. 

16

17 SUP. ANTONOVICH: OKAY THANK YOU, TAKE CARE, YOU'RE WELCOME, 

18 CONGRATULATIONS. [ APPLAUSE ] 

19

20 SUP. ANTONOVICH: NOW WE HAVE A LITTLE DOMESTIC SHORT HAIR CAT 

21 NAMED MINNIE WHO IS EIGHT WEEKS OLD. THIS IS LITTLE MINNIE. 

22 WANT TO SAY SOMETHING? NO THIS ONE DOESN'T SPEAK. OKAY. [ 

23 MEOWING ] 

24
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1 SUP. ANTONOVICH: ANYWAY, THIS IS LITTLE MINNIE. SHE'S LOOKING 

2 FOR A HOME. SHE COMES WITH A CHRISTMAS BOW. SEE ANYBODY HUH, 

3 SEE THEM? CAN YOU SAY SOMETHING, SAY SOMETHING. SAY SOMETHING. 

4 SO THOSE WHO ARE AT HOME WATCHING ON TELEVISION, YOU CAN CALL 

5 AREA CODE (562) 728-4644, OR ANYBODY IN THE AUDIENCE WHO WOULD 

6 LIKE TO ADOPT LITTLE MINNIE. SHE ALSO HAS SOME RELATIVES THAT 

7 WOULD LIKE TO BE ADOPTED AS WELL. [ INSISTENT MEOWING ] 

8

9 SUP. ANTONOVICH: OKAY. WELL SHE WAS ACTING UP SAYING SHE'D 

10 LIKE TO GO FIRST. OKAY, OKAY, SHE'S CUTE. BYE MINNIE, THAT'S A 

11 MINNIE. 

12

13 SUP. BURKE, CHAIR: SUPERVISOR MOLINA, DO YOU HAVE ANY 

14 PRESENTATIONS? I ASSUME SUPERVISOR MOLINA DOES NOT HAVE ANY 

15 PRESENTATIONS. OKAY. I'LL GO FORWARD, THEN. ARE OUR PEOPLE 

16 HERE? ARE OUR PEOPLE HERE? [ INDISTINCT VOICES ] 

17

18 SUP. BURKE, CHAIR: OKAY. ALL RIGHT. DO YOU WANT TO DO YOURS, 

19 SUPERVISOR YAROSLAVSKY? IS YOURS THE VIDEO PRESENTATION? GO 

20 AHEAD. 

21

22 SUP. YAROSLAVSKY: PARDON? IT'S GEORGE NICHOLAW. 

23

24 SUP. BURKE, CHAIR: YEAH. 

25
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1 SUP. YAROSLAVSKY: MADAM PRESIDENT -- MADAM CHAIR, I'D LIKE TO 

2 ASK GEORGE NICHOLAW TO COME DOWN AND... FOLKS TO COME DOWN. 

3 YEAH, ALL THE PEOPLE WHO ARE WITH GEORGE, COME ON DOWN. YOU'RE 

4 ALL WELCOME TO COME DOWN. ALL RIGHT. I THINK WE HAVE A SPECIAL 

5 PRESENTATION HERE. 

6

7 SUP. BURKE, CHAIR: CONGRATULATIONS. GOOD TO SEE YOU. 

8 CONGRATULATIONS! [ INDISTINCT VOICES ] 

9

10 VIDEO VOICE: HERE'S AN EDITORIAL BY GEORGE NICHOLAW, VICE 

11 PRESIDENT AND GENERAL MANAGER OF KNX. 

12

13 VOICE OF GEORGE NICHOLAW: THIS IS NOT A KNX EDITORIAL, IT IS A 

14 HEARTFELT MESSAGE FROM ME TO ALL KNX LISTENERS, TO ALL KNX 

15 CLIENTS AND TO ALL MEMBERS OF THE EXCEPTIONAL KNX STAFF. TODAY 

16 IS MY LAST DAY AS VICE PRESIDENT AND GENERAL MANAGER OF KNX 

17 DUE TO A MANAGERIAL REORGANIZATION. AFTER MORE THAN A RECORD-

18 BREAKING 36 YEARS IN THIS POSITION, I WOULD LIKE TO THANK ALL 

19 OF OUR LISTENERS AND ALL OF OUR CLIENTS FOR THEIR SUPPORT AND 

20 FOR THEIR LOYALTY. SINCE AUGUST OF 1967, WHEN I PRESENTED MY 

21 FIRST EDITORIAL, IT IS WITH PRIDE AND GOOD FORTUNE THAT I CAN 

22 SAY KNX HAS NOT MISSED ONE DAY OF PRESENTING AN EDITORIAL OR 

23 AN EDITORIAL REPLY. MY THANKS TO THE KNX EDITORIAL BOARD, 

24 MONICA MCGARVA, ED PYLE, DOTTIE SHARKY, PAT SMITH, AND 

25 EDITORIAL DIRECTOR DAVID ESIZE FOR THEIR EFFORTS TO INFORM OUR 



November 12, 2003

19

1 LISTENERS OF ISSUES OF CONCERN AND FOR APPLAUDING POSITIVE 

2 ACTION THAT MAKES OUR COMMUNITY A BETTER PLACE TO LIVE. MY 

3 THANKS TO KNX GENERAL SALES MANAGER, MIKE MASTERSON AND HIS 

4 STAFF FOR SUCCESSFULLY TELLING THE KNX STORY TO OUR CLIENTS. 

5 MY THANKS TO KNX NEWS DIRECTOR, ED PYLE, THE EXECUTIVE NEWS 

6 PRODUCER, RONNIE BRADFORD; AND OUR OUTSTANDING NEWS AND 

7 TECHNICAL TEAMS FOR LINING OUR HALLWAYS WITH HUNDREDS OF 

8 AWARDS FOR JOURNALISM AT ITS BEST. AND A SPECIAL THANKS TO MY 

9 EXECUTIVE ASSISTANT, PAT SMITH, THE PERFECT PARTNER. IT HAS 

10 BEEN A LONG RUN AND SHE HAS PLAYED A MAJOR ROLE IN OUR 

11 SUCCESS. TO ALL KNX LISTENERS, KEEP LISTENING. TO ALL KNX 

12 CLIENTS, KEEP YOUR MESSAGES ON OUR AIR SO OUR LISTENERS WILL 

13 REMEMBER YOU WHEN THEY NEED YOUR SERVICES OR YOUR PRODUCTS. 

14 AND TO ALL THE MEMBERS OF THE KNX STAFF, MY SINCERE 

15 APPRECIATION FOR YOUR VALUABLE CONTRIBUTION TO OUR STATION AND 

16 TO OUR COMMUNITY. KEEP DEDICATED IN PROVIDING OUR LISTENERS 

17 WITH THE FINEST AND MOST PROFESSIONAL NEWS COVERAGE IN 

18 SOUTHERN CALIFORNIA. FINALLY, TO ALL, REMEMBER THAT 1070 SPOT 

19 ON YOUR DIAL. KNX IS A GREAT RADIO STATION. [ APPLAUSE ] 

20

21 SUP. YAROSLAVSKY: MADAM PRESIDENT, WE HAVE REALLY BEEN BLESSED 

22 IN THIS CITY AND IN THIS REGION, ACTUALLY, ALL OVER THE 

23 WESTERN UNITED STATES, AND I'LL SPEAK TO THAT IN A SECOND, TO 

24 HAVE AT THE HELM AT KNX A MAN WITH THE COMMITMENT AND THE 

25 INTEGRITY OF GEORGE NICHOLAW. I GO BACK A LONG TIME WITH YOU, 
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1 LONG BEFORE I WAS AN ELECTED OFFICIAL, AND I ACTUALLY USED TO 

2 LIKE YOUR EDITORIALS WHEN THEY DIFFERED FROM MINE 'CAUSE IT 

3 GAVE ME AN OPPORTUNITY TO REBUT THEM, AND YOU ALWAYS GAVE YOUR 

4 90 SECONDS TO REBUT NO MATTER WHAT THE ISSUE AND NO MATTER HOW 

5 UNKNOWN THE RESPONDENT MIGHT BE, AND GOING BACK TO MY DAYS AS 

6 AN ADVOCATE FOR HUMAN RIGHTS BEHIND THE IRON CURTAIN, YOU WERE 

7 THERE AND AS AN ELECTED OFFICIAL, MY FIRST -- I BROUGHT YOU, 

8 GEORGE, I WENT INTO MY ATTIC AND I GOT YOU THE EDITORIAL WHERE 

9 YOU ENDORSED MY FIRST ELECTION TO THE CITY COUNCIL. 

10

11 SUP. BURKE, CHAIR: OH, HOW NICE! 

12

13 SUP. YAROSLAVSKY: AND I THOUGHT I'D READ SOME OF IT. [ 

14 LAUGHTER ] 

15

16 SPEAKER: ANOTHER COMMERCIAL COMING ON. 

17

18 SUP. YAROSLAVSKY: ANOTHER COMMERCIAL. [ LAUGHTER ] 

19

20 SUP. YAROSLAVSKY: BUT WE ACTUALLY -- THIS IS A VERY IMPORTANT 

21 ENDORSEMENT TO ME 'CAUSE I DIDN'T HAVE A LOT OF ENDORSEMENTS 

22 IN THAT ELECTION. MRS. BURKE WAS THE CHAIR OF MY OPPONENT'S 

23 CAMPAIGN. I FOUND THAT OUT IN THE ATTIC, TOO. I'D TOTALLY 

24 FORGOTTEN, BUT NOW I REMEMBER. BUT SERIOUSLY, WE REPRODUCED 

25 THIS EDITORIAL AND SENT IT TO EVERY HOUSEHOLD IN THE DISTRICT, 
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1 AND IT HAD A LOT OF INFLUENCE, BECAUSE YOUR STATION AND YOUR 

2 EDITORIALS HAVE BEEN SO MEANINGFUL TO PEOPLE ALL OVER SOUTHERN 

3 CALIFORNIA. I HAVE A DEFINITION -- IN OUR HOUSEHOLD, WE HAVE A 

4 DEFINITION OF WHAT A VACATION IS. A VACATION IS WHEN YOU GET 

5 FAR ENOUGH AWAY FROM LOS ANGELES SO THAT YOU CAN'T HERE KNX, 

6 AND I THOUGHT WE HAD THAT PRETTY WELL PLANNED WHEN I TOOK MY 

7 DAUGHTER ON A RIVER RAFTING TRIP ON THE SNAKE RIVER IN HELLS 

8 CANYON, I DON'T KNOW, 10, 12 YEARS AGO, AND ONE SUMMER NIGHT, 

9 GOT THE TENT UP, BEDDED DOWN FOR THE NIGHT, AND I HAD MY 

10 TRANSISTOR RADIO, AND I LIKED TO SEE WHAT LOCAL STATIONS CAN 

11 PICK UP, AND SURE ENOUGH, "THIS IS GEORGE NICHOLAW FROM KNX 

12 RADIO," AND SO EVEN IN HELLS CANYON, YOU'RE KNOWN. GEORGE, 

13 KNX, I THINK, IS IMPORTANT A NEWS STATION THAT THERE IS IN THE 

14 WHOLE UNITED STATES, AND YOU'VE BUILT THAT STATION INTO WHAT 

15 IT IS SINCE YOU TOOK IT OVER IN 1967. NOT JUST YOUR 

16 EDITORIALS, BUT THE QUALITY OF THE REPORTAGE, THE WHOLE SPAN 

17 OF COVERAGE ON BREAKING NEWS, ON FEATURES, ON THE ARTS, ON 

18 HOLLYWOOD, INTERNATIONAL, NATIONAL, AND YOU'VE JUST MADE THAT 

19 STATION INTO THE BELLWETHER AGAINST -- THE LIGHTHOUSE AGAINST 

20 WHICH EVERY OTHER STATION IN YOUR BUSINESS HAS TO NAVIGATE AND 

21 MEASURE ITSELF. WE ARE VERY LUCKY IN LOS ANGELES THAT KNX IS 

22 ONE OF OURS, SO WE'RE SORRY THAT YOU'RE NO LONGER AT KNX. 

23

24 GEORGE NICHOLAW: SO AM I! 

25



November 12, 2003

22

1 SUP. YAROSLAVSKY: BUT -- AND I THINK IT'S A GREAT LOSS TO BOTH 

2 KNX AS WELL AS TO THE COMMUNITY, BUT THE LEGACY YOU LEAVE IS 

3 GOING TO BE WITH US FOR GENERATIONS TO COME FOR BROADCAST 

4 JOURNALISTS WHO WILL ASPIRE TO DO WHAT YOU'VE DONE AND 

5 DOUBTFUL THAT THEY WOULD EVER BE ABLE TO SURPASS WHAT YOU'VE 

6 DONE, BUT, YOU KNOW, IN OUR HOUSEHOLD, GOING BACK -- MY MOTHER 

7 WAS A VERY -- LONG BEFORE YOU WERE THERE, KNX WAS OUR STATION, 

8 AND IT CONTINUES TO BE IN OUR HOUSEHOLD AND WE WISH YOU WELL, 

9 CONGRATULATE YOU ON 36 YEARS OF SERVICE TO KNX AND TO LOS 

10 ANGELES, AND WE WISH YOU THE BEST IN THE YEARS AHEAD. AND 

11 BEFORE YOU SAY ANYTHING, I WANT TO ASK MY COLLEAGUES IF THEY'D 

12 LIKE TO SAY A WORD, TOO. 

13

14 SUP. KNABE: MADAM CHAIR, AND MEMBERS OF THE BOARD, I JUST 

15 WANTED TO ADD TO WHAT ZEV SAID. I MEAN, ALL OF US THROUGHOUT 

16 THE YEARS, AND MY DAYS OF WORKING WITH GEORGE AS A MEMBER OF 

17 SUPERVISOR DANA'S STAFF TO MY ELECTION AND I KIDDED HIM THE 

18 OTHER NIGHT, WE HAD AN EVENT WITH THE L.A.U.D.C THAT I WAS 

19 REALLY HONORED WHEN THEY ENDORSED ME FOR MY FIRST ELECTION FOR 

20 THE BOARD OF SUPERVISORS, BUT GEORGE PLAYED IT ON A SATURDAY 

21 MORNING AT ABOUT 7:30, AND NO ONE WAS AWAKE, AND SO WE, TOO, 

22 HAD TO REPRODUCE THAT EDITORIAL. BUT I THINK THAT WE ALL HAVE 

23 VALUED HIS FAIRNESS AND SENSE OF CLASS JOURNALISM, AND IT'S 

24 BEEN A PLEASURE WORKING WITH HIM AND WISH YOU THE VERY, VERY 

25 BEST, GEORGE. 
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1

2 SUP. ANTONOVICH: LET ME ALSO ECHO IT. THERE ARE REALLY TWO 

3 VOICES IN SOUTHERN CALIFORNIA THAT HAVE BEEN REALLY AN 

4 INSTITUTION, AND THAT'S STAN CHAMBERS AND YOU, GEORGE. I MEAN 

5 YOU TWO ARE THE TWO ANCHORS OF THIS GREAT COUNTY AND REGION 

6 AND YOUR VOICE IS VERY FAMILIAR, BE IT MORNING, NOON, OR NIGHT 

7 WHEN YOU'RE TRAVELING, BUT GOING BACK TO 1969 WHEN I WAS 

8 ELECTED TO THE BOARD OF COMMUNITY COLLEGE'S BOARD OF TRUSTEES 

9 AND THROUGHOUT MY LEGISLATIVE CAREER, I'VE ALWAYS APPRECIATED 

10 YOUR ABILITY. I MEAN, YOU WERE ONE OF THE PROPONENTS OF THE 

11 MONORAIL DOWN THE 101 AND YOU WERE -- AND YOU'VE ALWAYS BEEN 

12 THERE, PLUS YOU ALLOW PEOPLE TO, WHEN THEY DISAGREE, TO HAVE 

13 THAT OPPORTUNITY TO SPEAK THEIR 90 SECONDS, AND I DON'T KNOW 

14 OF ANY OTHER RADIO STATION THAT ALLOWS THAT OPPORTUNITY, AND, 

15 PLUS, YOUR EDITORIALS ARE ALWAYS DONE WITH FORETHOUGHT AND 

16 ELOQUENCE AND A PROFESSIONALISM THAT NO OTHER STATION HAS, 

17 INCLUDING TELEVISION. I KNOW TELEVISION, I'VE USED EDITORIALS 

18 FROM TIME TO TIME, BUT IT'S A THING OF THE PAST. BUT YOU WERE 

19 REALLY A LEADER AND YOU'RE GOING TO BE MISSED, AND -- BUT 

20 YOU'VE BEEN A REAL GOOD ROLE MODEL THAT PERHAPS IN THE SCHOOLS 

21 OF JOURNALISM, THEY CAN USE YOU AS WHAT WE OUGHT TO HAVE 

22 INSTEAD OF THE SLEAZE THAT'S COMING OUT TODAY. BUT IT'S BEEN A 

23 PLEASURE TO HAVE BEEN ABLE TO GROW UP WITH YOU AND TO WORK 

24 WITH YOU IN OUR RESPECTIVE PROFESSIONS, BUT THANK YOU FOR YOUR 

25 LEADERSHIP. 
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1

2 SUP. BURKE, CHAIR: WELL, I DON'T KNOW WHAT TO SAY. I CAN'T 

3 IMAGINE KNX OR LOS ANGELES WITHOUT GEORGE. I KNOW HE'S GOING 

4 TO BE SOMEWHERE, WE'RE GOING TO HEAR HIS VOICE, WE'RE GOING TO 

5 HEAR HIS VIEWS AND HIS EDITORIALS, AND IT CERTAINLY WILL GIVE 

6 A WHOLE NEW DIMENSION TO OUR POLITICAL LIFE. WE CAN'T GIVE YOU 

7 UP, SO WE EXPECT TO HEAR YOU, AND WE EXPECT FOR YOU TO BE 

8 THERE TAKING PART IN PUBLIC POLICY, AND IT'S SO IMPORTANT THAT 

9 WE DO HAVE VIEWS THAT ARE EXPRESSED THAT ARE DETAIL ON SOME OF 

10 THOSE ISSUES OF THE DAY, AND YOU HAVE FULFILLED THAT ROLE, A 

11 ROLE THAT NO ONE ELSE CAN REALLY STEP INTO. I CAN REMEMBER 

12 BACK FOR SO MANY YEARS, I WON'T -- WHEN I SEE THAT PICTURE UP 

13 THERE, I'M NOT EVEN GOING TO SAY WHEN THAT WAS, BUT I'LL TELL 

14 YOU, IT'S BEEN A WHILE, IT'S BEEN A WHILE. BUT KNX, MY RADIO 

15 STAYS ON IT CONSTANTLY. I NEVER GET IN MY CAR WITHOUT IT BEING 

16 THERE, SO I HEAR YOUR VOICE ALL THE TIME, AND I CAN'T IMAGINE 

17 GETTING IN THE CAR WITHOUT HEARING YOUR VOICE. BUT LOTS OF 

18 LUCK TO YOU IN YOUR FUTURE, AND I KNOW THAT YOU WILL CONTINUE 

19 TO BE AN IMPORTANT PART OF OUR LANDSCAPE. [ APPLAUSE ] 

20

21 SUP. YAROSLAVSKY: GEORGE, THIS IS FOR YOU, AND IT'S -- I GUESS 

22 YOU COULD GET ONE OF THOSE TEE SHIRTS THAT SAYS, "I GAVE 36 

23 YEARS OF MY LIFE TO KNX AND ALL I GOT WAS THIS LOUSY 

24 RESOLUTION," BUT THAT'S A HEARTFELT RESOLUTION FROM ALL OF US 

25 AND WE WISH YOU WELL. 
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1

2 GEORGE NICHOLAW: WELL, THANK YOU VERY, VERY MUCH. YOU ALL KNOW 

3 HOW TO MAKE A GUY FEEL VERY, VERY GOOD. I MEAN THIS IS REALLY 

4 A VERY, VERY SPECIAL MOMENT FOR ME AND AS I GO BACK THROUGH 

5 THE YEARS, YVONNE AND I WERE BACK IN WASHINGTON, D.C. WHEN SHE 

6 WAS A CONGRESSWOMAN. THAT WAS A GOOD -- WELL, I WON'T EVEN SAY 

7 IT. BUT TO ALL OF YOU, MEMBERS OF THE ESTEEMED LOS ANGELES 

8 COUNTY BOARD OF SUPERVISORS, THANK YOU VERY, VERY MUCH FOR THE 

9 RECOGNITION THIS MORNING. I'D LIKE TO INTRODUCE A FEW MEMBERS 

10 OF THE FORMER KNX EDITORIAL BOARD, OUR EDITORIAL DIRECTOR, 

11 DAVID ESIZE; OUR EXECUTIVE ASSISTANT, PAT SMITH; OUR COMMUNITY 

12 SERVICES DIRECTOR ASSISTANT, DOTTIE SHARKY; AND OUR POLITICAL 

13 REPORTER FOR THE KNX 1070 NEWS ROOM, ALEX SULLIVAN. AND I 

14 THINK I BETTER -- [ APPLAUSE ] 

15

16  GEORGE NICHOLAW: YOU KNOW, MY WIFE BETTY SAID, "GEE, DON'T 

17 YOU EVER RETIRE." NOW SHE'S GOT ME AT HOME FOR LUNCH, AND ON 

18 TOP OF THAT, SHE'S PLAYING CHAUFFEUR AND ALMOST EVERYTHING 

19 UNTIL THIS SHOULDER INJURY, YOU KNOW, WHEN YOU'RE THROWN OUT 

20 THE WINDOW, YOU SOMETIMES DON'T LAND RIGHT. THE OPERATION WAS 

21 A COUPLE OF WEEKS AGO, AND SO I HAVE SURVIVED THAT PART OF IT 

22 AND BETTY IS STILL STRUGGLING. MY WIFE, BETTY. [ APPLAUSE ] 

23

24 GEORGE NICHOLAW: I KNOW YOUR TIME IS PRECIOUS, BUT I WANT ALL 

25 OF YOU TO KNOW THAT THIS IS AN IMPORTANT MOMENT FOR ME, AND I 
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1 WANT YOU ALL TO CONTINUE WORKING VERY, VERY HARD TO KEEP ALL 

2 YOUR CONSTITUENTS IN LOS ANGELES COUNTY HAPPY. THAT'S A VERY 

3 TOUGH THING TO DO, BUT I KNOW YOU CAN DO IT. THANK YOU AGAIN. 

4 ZEV THANK YOU SO MUCH. [ APPLAUSE ] [ FRIENDLY CHATTER ] [ 

5 INDISTINCT VOICES ] 

6

7 SUP. BURKE, CHAIR: WE NOW HAVE A VERY, VERY IMPORTANT 

8 PRESENTATION, AND WE WANT TO ASK THEM TO COME UP. WE CALL BUGS 

9 BUNNY, DAFFY DUCK, AND REPRESENTATIVES FROM WARNER BROTHERS 

10 FORWARD. GEORGE, YOU SEE WHO YOU'RE BEING FOLLOWED BY. WHAT 

11 AMERICAN DIDN'T GROW UP IN THE LAST 65 YEARS WHO DOESN'T KNOW 

12 BUGS BUNNY? HE FIRST APPEARED AS A CARTOON CHARACTER IN 1938, 

13 WON HIS FIRST STARRING ROLE IN 1940. LAST JULY, T.V. GUIDE 

14 PRONOUNCED BUGS BUNNY THE GREATEST CARTOON CHARACTER OF ALL 

15 TIMES. THAT'S RIGHT. NUMBER ONE! [ APPLAUSE ] 

16

17 SUP. BURKE, CHAIR: MICKEY MOUSE WAS NUMBER 19 IN THE SURVEY, 

18 AND THE PINK PANTHER AND OTHER BELOVED CHARACTERS DIDN'T EVEN 

19 MAKE THE LIST OF THE TOP 20. WHILE THERE'S SOME CONTROVERSY 

20 ABOUT THE LIST, SINCE IT'S NOT VERY CLEAR WHAT CRITERIA WERE 

21 USED IN THE SELECTION, THERE'S NO DOUBT THAT BUGS BUNNY IS ONE 

22 OF THE CARTOON ACTION CHARACTER GREATS. DUFFY DUCK, BUGS' 

23 SECOND FIDDLE, IS ALSO RIGHT UP THERE IN THE RATINGS, NUMBER 

24 14 ON THE T.V. GUIDE LIST. BOTH BUGS AND DUFFY WILL BE 

25 STARRING IN "BACK IN ACTION," A FEATURE FILM THAT'S BEING 
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1 RELEASED BY WARNER BROTHERS, WHICH IS BEING MADE AVAILABLE FOR 

2 A VERY SPECIAL SHOWING ON SATURDAY, NOVEMBER 15TH AT MAGIC 

3 JOHNSON THEATRE. AND THIS VERY SPECIAL AUDIENCE INCLUDES 300 

4 MEDICALLY FRAGILE CHILDREN WHO AT BIRTH HAD TO BE PUT INTO THE 

5 INFANT I.C.U. AT KING MEDICAL CENTER FOR INTENSIVE CARE, AND 

6 WHO ARE NOW OF AN AGE TO ENJOY THE ADVENTURES OF BUGS BUNNY 

7 AND DAFFY DUCK. AND ON THE OCCASION OF THIS EVENT I'M VERY 

8 PLEASED TO PROCLAIM SATURDAY, NOVEMBER 15TH 2003 AS WARNER 

9 BROTHERS LOONEY TUNES BACK IN ACTION DAY THROUGHOUT LOS 

10 ANGELES COUNTY. IN COMMEMORATION I HEREBY PRESENT THIS SCROLL 

11 TO CHRIS DEFARIA, EXECUTIVE PRODUCER AND SENIOR VICE PRESIDENT 

12 OF FEATURE PRODUCTIONS FOR WARNER BROTHERS PICTURES, AND 

13 BERNIE GOLDMAN, PRODUCER, AND THEY WILL SPEAK ON BEHALF OF 

14 DAFFY DUCK AND BUGS BUNNY. THANK YOU SO MUCH. FIRST OF ALL, I 

15 APPRECIATE SO MUCH YOU HAVING THIS SHOWING, FOR THESE CHILDREN 

16 WHO SURVIVED AND WHO HAVE COME THROUGH SUCH DIFFICULT TIMES. 

17 AND WE ALL ENJOYED AS WE GREW UP, BUT FOR THESE CHILDREN 

18 THEY'RE LUCKY TO BE ABLE TO ENJOY IT, AND IT MAKES SUCH A 

19 DIFFERENCE IN THEIR LIVES. SO WE'RE GOING TO TAKE A PHOTO. IF 

20 WE CAN GET EVERYONE AND THEN WHO'S GOING TO SPEAK? ARE YOU 

21 SPEAKING? OKAY, WE HAVE TO GET AROUND, OKAY. [ INDISTINCT 

22 FRIENDLY CHATTER ] 

23

24 SUP. BURKE, CHAIR: OKAY, YOU'RE SPEAKING FOR THEM. 

25
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1 SPEAKER: I AM. I WONDER IF IT'S TOO LATE TO RUN THE PET 

2 ADOPTION PART OF THE PROGRAM ONE MORE TIME. [ LAUGHTER ] 

3

4 SPEAKER: NO, ON BEHALF OF WARNER BROTHERS, WHO HAS BEEN PART 

5 OF THE LOS ANGELES COMMUNITY FOR MORE THAN 75 YEARS -- I WAS 

6 GOING TO SAY ON BEHALF OF WARNER BROTHERS WHO HAS BEEN PART OF 

7 THE LOS ANGELES COMMUNITY FOR MORE THAN 75 YEARS I WANT TO 

8 THANK SUPERVISOR BURKE AND THE BOARD FOR THIS HONOR. AND I 

9 ALSO REALLY WANT TO COMMEND THE BOARD ON THEIR RECOGNITION OF 

10 THE HIGH-RISK INFANT PROGRAM FOR WHICH WE'RE DOING THIS 

11 SCREENING. IT'S A WORTHY ORGANIZATION, OBVIOUSLY A WORTHY 

12 CAUSE, AND IT'S AN EXTRAORDINARY OPPORTUNITY FOR US TO PRESENT 

13 THIS FILM TO A GROUP OF KIDS WHO I DON'T THINK HAVE MET THESE 

14 CHARACTERS YET, AND WE ARE SURE GOING TO LEARN TO LOVE THEM. 

15 THANK YOU VERY MUCH. 

16

17 SUP. BURKE, CHAIR: THANK YOU SO MUCH. [ APPLAUSE ] 

18

19 SUP. BURKE, CHAIR: THANK YOU VERY MUCH. [ INDISTINCT VOICES ] 

20

21 SUP. BURKE, CHAIR: GETTING DOWN THOSE STAIRS I KNOW IS A BIG 

22 TRICK. 

23

24 SPEAKER: THAT CONCLUDES OUR PRESENTATION SUPERVISOR. 

25
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1 SUP. BURKE, CHAIR: OKAY, SUPERVISOR KNABE? 

2

3 SUP. KNABE: YES MADAM CHAIR AND MEMBERS OF THE BOARD, 

4 YESTERDAY, WE ALL CELEBRATED PAST MEMORIES AND CURRENT 

5 TRIUMPHS OF OUR NATION'S SONS AND DAUGHTERS WHO ARE CURRENTLY 

6 SERVING IN SEVERAL THEATERS OF OPERATIONS THROUGHOUT THIS 

7 WORLD. AS VETERAN DAY SYMBOLIZES THEIR CONTRIBUTIONS TO THE 

8 WORLD, LET US ALSO RECOGNIZE THE MANY VETERANS WHO HAVE JOINED 

9 WITH LOCAL POLICE, FIRE, AND EMERGENCY PERSONNEL TO STRENGTHEN 

10 OUR NATION'S HOMELAND SECURITY AS WELL. THESE PUBLIC SERVANTS 

11 GO WAY BEYOND THE CALL OF DUTY EACH AND EVERY DAY TO PROTECT 

12 OUR COMMUNITIES, FAMILIES, BUSINESSES AND PUBLIC PLACES. SO 

13 IT'S IMPORTANT TO RECOGNIZE THEIR VALOR AS WELL. BUT TO 

14 COLONEL SMITH, IN RECOGNITION OF THAT VERY SPECIAL DAY, AND WE 

15 WERE ALL AT SEVERAL DIFFERENT PROGRAMS YESTERDAY THROUGHOUT 

16 THIS GREAT COUNTY IN CELEBRATION OF VETERANS' DAY IN HONORING 

17 THE MEN AND WOMEN WHO HAVE GIVEN SO MUCH THAT WE COULD 

18 CELEBRATE AND TO HONOR THOSE THAT ARE IN SERVICE RIGHT NOW. ON 

19 BEHALF OF MYSELF AND MY COLLEAGUES, WE'D LIKE TO PRESENT YOU 

20 THIS SCROLL IN RECOGNITION OF VETERANS' DAY 2003. [ APPLAUSE ] 

21

22 JOSEPH N. SMITH: THANK YOU. IT'S AN HONOR AND A PRIVILEGE TO 

23 BE HERE REPRESENTING THE OVER 538,000 VETERANS THAT WE HAVE 

24 HERE IN LOS ANGELES COUNTY AS WELL AS THE MORE THAN A MILLION 

25 DEPENDENTS AND SURVIVORS WHO ALSO SACRIFICE WHILE THEIR LOVED 
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1 ONES ARE OVERSEAS. AS THE SUPERVISOR MENTIONED, WE HAVE SONS 

2 AND DAUGHTERS SERVING OVERSEAS TODAY. WE APPRECIATE THE 

3 SUPPORT OF OUR BOARD, OUR SUPERVISORS, AND THE ENTIRE COUNTY 

4 FAMILY IN RECOGNIZING AND BACKING THE VETERANS AND THEIR 

5 FAMILIES AND THE YOUNGSTERS OVERSEAS. THANK YOU VERY MUCH. [ 

6 APPLAUSE ] 

7

8 SUP. KNABE: MADAM CHAIR, THAT CONCLUDES MY PRESENTATION. 

9

10 SUP. BURKE, CHAIR: OKAY. WE'LL START WITH -- [ INDISTINCT 

11 VOICES ] 

12

13 SUP. BURKE, CHAIR: FOR YOUR ADJOURNMENTS. 

14

15 SUP. ANTONOVICH: LET ME FIRST MOVE MADAM CHAIR THAT WE ADJOURN 

16 IN MEMORY OF DOROTHY SOUTHWORTH RITTER, WHO WAS THE WIDOW OF 

17 TEX RITTER, MOTHER OF JOHN RITTER, WHO PASSED AWAY LAST MONTH, 

18 AND ALSO WAS AN ACTRESS. SHE PERFORMED IN A NUMBER OF FILMS, 

19 AND THAT'S WHERE SHE MET HER HUSBAND, TEX RITTER, IN ONE OF 

20 THE FILMS THAT SHE WAS PERFORMING IN, AND I FIRST MET HER WHEN 

21 SHE WAS A MEMBER OF THE REAGAN DELEGATION, WHEN PRESIDENT 

22 REAGAN RAN THE FIRST TIME FOR THE PRESIDENCY AND WE TRAVELED 

23 BACK TO KANSAS CITY FOR THE CONVENTION. SHE'S A -- SHE WAS A 

24 WONDERFUL PERSON AND SHE IS SURVIVED BY TOM, HER OTHER SON, 

25 AND HIS WIFE, PAMELA, AND HER GRANDCHILDREN. ALSO, I'D LIKE TO 
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1 MOVE THAT WE ADJOURN IN MEMORY OF LIEUTENANT TODD BRYANT. 

2 LIEUTENANT BRYANT WAS A GRADUATE OF LA CANADA HIGH SCHOOL, AND 

3 HE ATTENDED THE MILITARY ACADEMY AT WEST POINT, AND AT THE -- 

4 AND WAS KILLED AT THE AGE OF 23 IN THE CONFLICT IN IRAQ. ALSO, 

5 THE GREAT ACTOR, ART CARNEY, WHO PASSED AWAY. BOBBY HATFIELD 

6 OF THE RIGHTEOUS BROTHERS. AND BOBBY -- 

7

8 SUP. KNABE: I WANT TO BE ON BOBBY'S -- 

9

10 SUP. ANTONOVICH: PERFORMED AT OUR ANNUAL RICE AND BEANS ROCK 

11 AND ROLL SHOW THAT I HOST EACH YEAR AT MINNELLI PARK. AND THE 

12 RIGHTEOUS BROTHERS PERFORMED AND DID THE SONG THAT WAS AT OUR 

13 WEDDING, "UNCHAINED MELODY" FOR MY WIFE AND I THAT THEY 

14 PERFORMED. THEY WERE VERY NICE AND DIED A VERY YOUNG AGE OF 

15 63. A VERY YOUNG AGE. 

16

17 SUP. BURKE, CHAIR: GETS YOUNGER EVERY YEAR. 

18

19 SUP. ANTONOVICH: EVERY YOUNGER EVERY YEAR RIGHT. ALSO, JOHANNA 

20 HOFFER, WHO WAS A FORMER L.A. UNIFIED SCHOOL DISTRICT 

21 EMPLOYEE, WHERE SHE SERVED AS A PRINCIPAL AT MUIR VAN NUYS 

22 JUNIOR HIGH AND CLEVELAND HIGH SCHOOL, AND SHE WAS ALSO THE 

23 GIRLS' VICE PRINCIPAL AT EDISON JUNIOR HIGH SCHOOL, WHERE I 

24 ATTENDED MANY YEARS AGO. CELESTE PHYLLIS HUFFINGTON WHO PASSED 

25 AWAY. AND SHE -- HER HUSBAND, ROY HUFFINGTON, SERVED AS UNITED 
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1 STATES AMBASSADOR TO AUSTRIA FROM 1990 TO 1993. REBECCA GENE 

2 SHOWER PETROVIC, WHO PASSED AWAY AT THE AGE OF 49. AND NORMAN 

3 EVOLIN, A FORMER RESIDENT OF SANTA CLARITA, AND WAS THE 

4 SUPERVISOR AT THE MRS. GOOCHES MARKETS, PASSED AWAY AT THE AGE 

5 OF 85. 

6

7 SUP. BURKE, CHAIR: SO ORDERED. 

8

9 SUP. ANTONOVICH: I HAVE A MOTION THAT I WOULD LIKE TO WAIVE 

10 THE 72-HOUR AND THAT DEALS WITH THE FIRE THAT WE HAD ON 

11 NOVEMBER 4TH. THE STATE COMMUNITY SERVICES AND DEVELOPMENT 

12 DEPARTMENT NOTIFIED OUR COMMUNITY AND SENIOR SERVICES ON THE 

13 AVAILABILITY OF THE $100,000 DISCRETIONARY EMERGENCY FUNDS FOR 

14 THE L.A. COUNTY FIRE VICTIMS. THE FUNDS WERE RELEASED TO 

15 ASSIST THE VICTIMS OF THE RECENT FIRES WHO WERE DIRECTLY OR 

16 INDIRECTLY AFFECTED. THREE COMMUNITY-BASED ORGANIZATIONS 

17 LOCATED NEAR THE FIRE DISASTER AREA ARE RECOMMENDED FOR 

18 FUNDING TO IMMEDIATELY PROVIDE SERVICES, INCLUDING BUT NOT 

19 LIMITED TO FOOD VOUCHERS, HOTEL VOUCHERS, HOUSING ASSISTANTS, 

20 RELOCATION EXPENSES, CONSUMER PROTECTION INFORMATION, 

21 EDUCATION SEMINARS AND COUNSELING FOR THE VICTIMS. SO I'D MOVE 

22 THAT THE BOARD DIRECT THE COMMUNITY AND SENIOR SERVICES 

23 DIRECTOR TO ACCEPT THE $100,000 DISCRETIONARY EMERGENCY FUNDS 

24 AND TO EXECUTE THE CONTRACTS WITH THE FOLLOWING AGENCIES 

25 ALLOWING FOR THE FLEXIBILITY OF FUNDS TO ENSURE THE VICTIMS' 
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1 NEEDS ARE MET. AND THAT WOULD BE TO THE TRI-CITY MENTAL HEALTH 

2 CENTER, THE NEIGHBORHOOD LEGAL SERVICES CENTER OF LOS ANGELES 

3 COUNTY, AND THE L.A. FAMILY HOUSING CORPORATION. TO MAKE THAT 

4 AS A MOTION. 

5

6 SUP. BURKE, CHAIR: SECONDED BY KNABE. WITHOUT OBJECTION, SO 

7 ORDERED. 

8

9 SUP. ANTONOVICH: AND I WOULD LIKE TO CALL UP ITEM NUMBER 3. 

10

11 SUP. BURKE, CHAIR: GENEVIEVE CLAVREUL HAS ASKED TO SPEAK ON 

12 THAT, AND SHE ALSO ASKED TO SPEAK ON ONE OTHER ITEM, WHICH IS 

13 ITEM NUMBER 24, SO IF YOU CAN CALL BOTH ITEMS AT THE SAME 

14 TIME. 

15

16 SUP. ANTONOVICH: OKAY. 24 AND 3. 

17

18 GENEVIEVE CLAVREUL: THIS IS GENEVIEVE CLAVREUL. GOOD MORNING, 

19 BOARD OF SUPERVISORS. FIRST OF ALL, I WANT TO COMPLIMENT YOU, 

20 SUPERVISOR ANTONOVICH, IN BRINGING THAT MOTION. I THINK IT'S 

21 ESSENTIAL THAT WE DEAL WITH ANY KIND OF HATE CRIME OR HATE 

22 BEHAVIOR IN THIS NATION. LAST WEEK, I ASKED YOU A QUESTION TO 

23 THE BOARD, WHY THE HUMAN RELATION COMMISSION WAS TAKING ON THE 

24 ISSUE ON THE LAS MEMORIAL WALLS. AND INITIALLY WHEN THAT ISSUE 

25 WAS BROUGHT TO THE BOARD, SUPERVISOR MOLINA MADE IT PLAIN THAT 
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1 IT WAS NOT UNDER THE JURISDICTION OF THE COUNTY, BUT THE 

2 JURISDICTION OF L.A. COUNTY. I STILL WOULD LIKE A RESPONSE. 

3 AND, OF COURSE, NOBODY IS WILLING TO RESPOND TO THAT. AND I 

4 WOULD LIKE TO KNOW WHY THAT ISSUE HAVE CHANGED. WHEN IT COMES 

5 TO LAS MEMORIAL WALL IT'S NOT AN ISSUE OF HATE OR OF 

6 HOMOPHOBIA, THE ISSUE IS THAT WE WANT TO KNOW WHERE THE MONEY 

7 THEY HAVE RECEIVED HAVE GONE. WE HAVE DEMANDED TO LOOK AT THE 

8 BOOK. IT HAS NOTHING TO DO WITH HOMOPHOBIA, AND I WANT TO KNOW 

9 WHY IS THE COUNTY MEDDLING IN L.A. CITY AFFAIRS. AND MS. 

10 MOLINA, IT WILL BE NICE IF YOU DO BEHAVE LIKE YOU PRETEND TO 

11 LISTEN. I WILL BE COMING BACK EVERY WEEK UNTIL I FIND OUT WHAT 

12 HAPPENED TO THAT ISSUE. I WANT TO KNOW WHERE THE MONEY HAVE 

13 GONE, INCLUDING COUNTY MONEY. I WANT TO KNOW WHERE THE 

14 $900,000 FROM THE CITY WENT, AND I WANT TO KNOW WHY NOW 

15 THEY'RE GOING TO RECEIVE AN ADDITIONAL 400,000 FROM THE STATE. 

16 ALL WE WANT TO KNOW IS SEE THE BOOK. IT HAS NOTHING TO DO WITH 

17 HOMOPHOBIA. ON THE ISSUE OF NUMBER -- ITEM 24, I'M REALLY 

18 AMAZED THAT WE HAVEN'T OVERLOOKED AND THE ISSUES THAT WE NEED 

19 TO AMEND BECAUSE INADVERTENTLY IT'S A MAXIMUM OBLIGATION 

20 STATED INCORRECTLY. WE'RE TALKING ABOUT $616,000. HOW CAN YOU 

21 MAKE THOSE KIND OF INADVERTENT MISTAKES IN YOUR CONTRACT? YOU 

22 KNOW, WE HAVE A LOT OF THOSE THINGS GOING ON HERE ALL THE 

23 TIME. THERE IS DEFINITELY A PROBLEM WITH EFFICIENCY WITH THE 

24 COUNTY. AND I KNOW MANY OF YOU DON'T CARE, BUT AT LEAST 

25 PRETEND. I WAS VERY GLAD TO SEE THAT THEY BROUGHT THE BROWN 
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1 ACT YOU LOST WHEN YOU WENT TO APPEAL AND YOU WERE FINDING 

2 WRONG ABOUT VIOLATING THE BROWN ACT. YOU ARE AGAIN VIOLATING 

3 THE BROWN ACT. THE LITTLE BLUE PIECE OF PAPER YOU'RE PASSING 

4 OUT EVERY WEEK IS APPALLING. YOU ARE VIOLATING THE SPIRIT OF 

5 THE LAW. YOU ARE SHOWING SO MUCH DISCONTENT FOR THE PUBLIC, 

6 YET YOU'RE FORCING THE PUBLIC TO BEHAVE BADLY. PERSONALLY, I 

7 WON'T GIVE YOU THAT PLEASURE, BECAUSE I'M NOT GOING TO LOWER 

8 MYSELF TO YOUR TACTICS. BUT LOOK NOT THE SAME, I AM TOTALLY 

9 APPALLED BY YOUR BEHAVIOR. YOU ARE HERE AT THE DISCRETION OF 

10 THE PUBLIC, AND I WANT TO REMIND THAT TO YOU. AND FOR SO LONG, 

11 YOU CAN BE SO DISREGARDING. THANK YOU FOR YOUR ATTENTION. 

12

13 SUP. ANTONOVICH: MOVE ITEM NUMBER 3. 

14

15 SUP. KNABE: SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

16

17 SUP. ANTONOVICH: MOVE ITEM 24. 

18

19 SUP. BURKE, CHAIR: MOVED -- SECONDED BY KNABE, WITHOUT 

20 OBJECTION, SO ORDERED. 

21

22 SUP. ANTONOVICH: ITEM NUMBER 5. 

23

24 SUP. BURKE, CHAIR: MERRITT HOLLOWAY HAS ASKED TO SPEAK ON 

25 THIS, AND WE'LL HAVE TO TAKE ALL OF THE ITEMS HE HAS ASKED TO 



November 12, 2003

36

1 SPEAK ON, WHICH ARE 5, 9, 10, 11, 12, 16, 19, 21, 48, 25, 35, 

2 36, 38, 39, 49, 50, 52, AND 53. ALL OF THOSE ITEMS ARE BEFORE 

3 US. 

4

5 SUP. MOLINA: MADAM CHAIR? 

6

7 SUP. BURKE, CHAIR: YES? 

8

9 SUP. MOLINA: I AM GOING TO CHALLENGE MR. HOLLOWAY'S RIGHT TO 

10 SPEAK ON ALL OF THOSE ITEMS. I THINK THAT, YOU KNOW, WE HAVE -

11 - WE HAVE TO HONOR AND SHOULD HONOR THE BROWN ACT. THERE ARE 

12 MANY CONSTITUENTS, MANY OF OUR RESIDENTS IN L.A. COUNTY WHO 

13 LEGITIMATELY COME HERE TO ADDRESS ISSUES BEFORE THIS BOARD, 

14 AND WE TRY AND BE AS ATTENTIVE AS POSSIBLE AND RESPOND TO 

15 THOSE ISSUES WHEN CAN RESPOND, EVEN THOUGH MRS. CLAVREUL 

16 THINKS OTHERWISE, BUT WE'RE CONCERNED. MR. HOLLOWAY IS MAKING 

17 A MOCKERY OF OUR BROWN ACT, AND I'M NOT GOING TO PERMIT HIM 

18 AND I AM CHALLENGING HIM ON THESE ISSUES. HE PULLED 17 ITEMS, 

19 AND IF HE WISHES TO ADDRESS AN ITEM, I'M GOING TO SAY THAT HE 

20 BE PERMITTED TO ADDRESS ONE, TWO, OR THREE ITEMS, BUT THIS IS 

21 A JOKE AND I WON'T LET YOU DO IT. SO, I AM SAYING TO YOU, MS. 

22 BURKE, AND OTHERS, THAT FROM NOW ON, HE COMES UP, HE CHOOSES 

23 HIS ITEMS. WE'RE NOT GOING TO ALLOW HIM TO HOLD OFF ON THOSE 

24 ITEMS. 

25
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1 MERRITT HOLLOWAY: OKAY. I DISAGREE. 

2

3 SUP. MOLINA: EXCUSE ME! EXCUSE ME! AND SO I WOULD LIKE TO MAKE 

4 SURE THAT THIS DOES NOT HAPPEN AGAIN. HE'LL COME IN NEXT WEEK 

5 AND MOCK US EVEN MORE AND HOLD ALL 55 ITEMS, IF HE WOULD LIKE, 

6 AND I THINK THIS HAS TO STOP, AND HE HAS TO UNDERSTAND AND BE 

7 RESPECTFUL OF THE RULES. SO, THAT'S IT. 

8

9 MERRITT HOLLOWAY: OKAY. OKAY. I'D LIKE TO RESPOND BEFORE MY 

10 TIME STARTS, BECAUSE JUST LET ME SAY THIS -- 

11

12 SUP. MOLINA: NOW SIR, LISTEN, HEY! 

13

14 MERRITT HOLLOWAY: OKAY, IT'S MY TIME NOW. 

15

16 SUP. MOLINA: MS. BURKE, I HAVE NOT FINISHED SPEAKING HERE SIR. 

17

18 SUP. BURKE, CHAIR: OKAY. FIRST OF ALL -- ALL RIGHT. FIRST OF 

19 ALL, COUNTY COUNSEL, I AM GOING TO RULE THAT HE CAN CHOOSE ONE 

20 ITEM TO SPEAK ON. 

21

22 MERRITT HOLLOWAY: OKAY. THAT'S AGAINST THE BOARD -- I MEAN 

23 AGAINST THE BROWN ACT. 

24
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1 SUP. BURKE, CHAIR: JUST A MOMENT. WAIT A MINUTE, SIR! THE 

2 COUNTY -- I'VE ASKED THE COUNTY COUNSEL TO RULE ON THAT. 

3

4 COUNSEL PELLMAN: THAT WOULD BE CONSISTENT WITH THE WAY THE 

5 STATUTE IS WRITTEN. 

6

7 SUP. BURKE, CHAIR: IT'S CONSISTENT WITH THE STATUTE. 

8

9 COUNSEL PELLMAN: IT SAYS THE PUBLIC MAY ADDRESS ANY ITEM, 

10 SINGULAR. 

11

12 SUP. BURKE, CHAIR: ALL RIGHT, NOW MR. -- LET ME TELL YOU MR. 

13 HOLLOWAY, YOU HAVE ONE -- YOU CAN SPEAK ON ONE ITEM. 

14

15 MERRITT HOLLOWAY: OKAY, EXCUSE ME, MAYOR BURKE. 

16

17 SUP. BURKE, CHAIR: ALL RIGHT AND YOU HAVE -- LET ME TELL YOU 

18 WHAT YOUR ALTERNATIVE IS. YOU CAN FILE A LAWSUIT AGAINST US. 

19

20 MERRITT HOLLOWAY: OKAY. 

21

22 SUP. BURKE, CHAIR: THAT'S YOUR ALTERNATIVE. YOU CAN'T ARGUE 

23 THE ISSUE. WE'VE HEARD YOUR ARGUMENT. 

24
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1 MERRITT HOLLOWAY: OKAY. I JUST WANT TO SAY ACCORDING TO THE 

2 BROWN ACT, MAYOR -- MAYOR YVONNE BRATHWAITE-BURKE, IT SAYS 

3 THAT THE PUBLIC HAS THE RIGHT TO ADDRESS ANY ITEM ON THE 

4 AGENDA AT ANY OPEN MEETING AND NOT ONLY THAT, THAT THEY HAVE 

5 THE RIGHT TO SPEAK ON ANY ITEM OR ANY ISSUE THAT'S WITHIN THE 

6 JURISDICTION OF THE LOS ANGELES COUNTY! NOW THAT'S ACCORDING 

7 TO THE BROWN ACT OKAY. 

8

9 SUP. BURKE, CHAIR: ALL RIGHT, YOU CAN GET AN ATTORNEY TO FILE 

10 A LAWSUIT. 

11

12 MERRITT HOLLOWAY: AND I HAVE LEGITIMATE ISSUES THAT I'M 

13 SPEAKING ON ON ALL OF THESE ITEMS, AND, YOU KNOW, AND I AM THE 

14 PUBLIC AND YOU DO WORK FOR US, AND I NEED TO HAVE FAIR 

15 OPPORTUNITY TO BE HEARD OUT, AND AS FAR AS BEING A MOCKERY, 

16 THIS IS SERIOUS. OKAY. NOW I WANT TO TALK ABOUT THESE ITEMS. 

17 ITEM 5, 9, 10, 11, AND 12, AND THEN ALSO ITEM 39. 

18

19 SUP. BURKE, CHAIR: YOUR TIME IS RUNNING. 

20

21 MERRITT HOLLOWAY: OKAY? OKAY. THOSE ITEMS RIGHT THERE, WE NEED 

22 TO STOP WAIVING THE FEES. ALL OF THOSE ITEMS ARE FOR -- SO 

23 THAT WHOEVER CAN COME TO WHEREVER AND GET FREE PARKING AND GET 

24 THIS AND THAT, WITH ALL OF THE BUDGET PROBLEMS THAT WE'RE 

25 HAVING IN THE CITY, ALL THOSE ITEMS THEY NEED TO -- WE NEED TO 
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1 STOP ALL FEE WAIVERS. SO ITEM 5, 9, 10, 11 AND 12. I OBJECT TO 

2 THOSE ITEMS. OKAY NOW AS FAR AS ITEM 53, 52, 50 AND 49, WE 

3 NEED TO HAVE -- TO SAY IN ALL OF THOSE CABLE COMPANIES THAT IT 

4 NEEDS TO BE PUBLIC EDUCATION AND GOVERNMENT ACCESS. OKAY. SO 

5 ALL OF THOSE THINGS NEED TO SAY "PUBLIC EDUCATION AND 

6 GOVERNMENT ACCESS" SO THAT THE PUBLIC HAS THE RIGHT TO BE -- 

7 TO GO TO ANY OF THOSE CABLE COMPANIES. OKAY NOW ALSO TOO ON 

8 ITEM 38, 36, 5, 33, 31, AND 18, THAT'S THE C.E.Q.A. OKAY NOW, 

9 I'M GOING TO REFER YOU TO ITEM NUMBER 4, WHICH IS THE ITEM 

10 WHERE YOU'RE TALKING ABOUT CLEANING UP THE CITY, OKAY, BUT YET 

11 YOU'RE READY TO LET THE CALIFORNIA ENVIRONMENTAL QUALITY ACT -

12 - YOU'RE LETTING 38, 36, 35, 33, 21, AND 18, YOU'RE ALLOWING 

13 THEM TO BECOME EXEMPT. WE NEED TO STOP ALLOWING THESE 

14 POLLUTERS TO BECOME EXEMPT ON THAT. NOW, TO GO ON ABOUT THE 

15 DEPARTMENT OF CHILDREN AND FAMILY SERVICES, WHICH IS NUMBER -- 

16 I THINK IT'S NUMBER 19 AND 20, OKAY, THERE'S A PETITION HERE 

17 FOR WE THE MEMBERS OF THE PUBLIC AND RESIDENTS OF THE COUNTY 

18 OF LOS ANGELES DO REQUEST THE COUNTY OF LOS ANGELES BOARD OF 

19 SUPERVISORS TAKE IMMEDIATE ACTION CONCERNING THE VILE AND 

20 PROFANE CONDUCT OF ONE OF ITS MEMBERS, SUPER ZEV YAROSLAVSKY. 

21 SUPER ZEV DISPLAYED DISORDERLY, CONTEMPTUOUS AND INSOLENT 

22 BEHAVIOR WHEN HE USED PROFANITY IN ORDER TO INSULT ONE OF THE 

23 PUBLIC SPEAKERS. AND IN ADDITION TO INSULTING HER THEY NEVER 

24 LET HER SPEAK FOR HER FULL TIME. OKAY, NOW AS FAR AS YOU, 

25 SUPER BURKE, THERE'S GOING TO BE A BIG RALLY THIS WEEKEND. 
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1 ALSO, WHAT IS GOING ON WITH MY CASE? OKAY? AND ALL OF THE 

2 CRIMINAL ACTIVITY THAT'S BEING DONE BY THE CORRUPT JUDGES AND 

3 EVERYTHING LIKE THAT. NOW SUPER BURKE, WHERE IS L.A. COUNTY'S 

4 MONEY GONE? INVESTMENTS IN SOUTH AFRICA? CAYMAN ISLAND? OKAY. 

5 OKAY. WHERE IS THE MONEY? 

6

7 SUP. BURKE, CHAIR: IS HIS TIME UP YET? 

8

9 MERRITT HOLLOWAY: OKAY, ALSO TOO WE'RE HAVING A RECALL FOR 

10 SUPERVISOR BURKE AND YAROSLAVSKY THIS SUNDAY, NOVEMBER 16TH, 

11 THE CITIZENS OF L.A. -- 

12

13 SUP. BURKE, CHAIR: YOUR TIME HAS EXPIRED. THANK YOU VERY MUCH. 

14 YOUR TIME HAS EXPIRED. 

15

16 MERRITT HOLLOWAY: OKAY AND ALSO TOO I'M GOING TO SPEAK UNDER 

17 PUBLIC COMMENT AND THANK YOU. 

18

19 SUP. BURKE, CHAIR: ALL RIGHT. 

20

21 MERRITT HOLLOWAY: AND ALSO TOO THIS NEEDS -- 

22

23 SUP. BURKE, CHAIR: YOUR TIME HAS EXPIRED. 

24
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1 MERRITT HOLLOWAY: GIVE IT TO THE BOARD, THIS NEEDS TO BE -- 

2 AND THE PEOPLE -- 

3

4 SUP. BURKE, CHAIR: YOUR TIME HAS EXPIRED. 

5

6 SPEAKER: YOUR TIME EXPIRED, DON'T INTERRUPT. 

7

8 MERRITT HOLLOWAY: OKAY PLEASE RAISE YOUR HAND. 

9

10 SPEAKER: STOP. 

11

12 SPEAKER: THEY NEED COPIES OF THAT AND -- 

13

14 SUP. BURKE, CHAIR: ALL RIGHT, DO YOU HAVE A MOTION ON ALL 

15 THOSE ITEMS? 

16

17 SUP. ANTONOVICH: I MOVE THE -- A MOTION ON ALL OF THOSE ITEMS 

18 THAT WERE HELD. 

19

20 SUP. BURKE, CHAIR: AND SECONDED BY KNABE. WITHOUT OBJECTION, 

21 SO ORDERED. YOU KNOW, I'M GOING TO ASK THE COUNTY COUNSEL TO 

22 COME BACK WITH A RULE THAT A PERSON CAN ONLY SPEAK ON -- 

23

24 COUNSEL PELLMAN: ON ONE ITEM. 

25
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1 SUP. BURKE, CHAIR: ONE ITEM. 

2

3 COUNSEL PELLMAN: WITHOUT THE PERMISSION OF THE CHAIR? 

4

5 SUP. BURKE, CHAIR: RIGHT. 

6

7 COUNSEL PELLMAN: WOULD YOU WANT IT -- THE STATUTE SAYS ANY 

8 ITEM, SINGULAR, AND IT HISTORICALLY HAD SAID MULTIPLE ITEMS. 

9

10 SUP. BURKE, CHAIR: BUT THEY'VE CHANGED IT? 

11

12 COUNSEL PELLMAN: IT WAS CHANGED AT LEAST 10 YEARS AGO, I 

13 BELIEVE, TO BE SINGULAR, AND WE WILL PREPARE SOMETHING FOR THE 

14 BOARD'S CONSIDERATION. 

15

16 SUP. BURKE, CHAIR: RIGHT. AND IF IT IS ANY PERSON WHO HAS MORE 

17 THAN ONE ITEM THAT IS -- THAT THEY HAVE A SPECIFIC INTEREST 

18 IN, WE WOULD LIKE TO HAVE A STATEMENT AT THE TIME THAT THEY 

19 ADDRESS THEIR FIRST ITEM AND WE CAN CONSIDER IT IN THAT ITEM. 

20

21 MERRITT HOLLOWAY: THAT'S FINE AND I'LL MAKE A STATEMENT YOUR 

22 HONOR BURKE. 

23
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1 SUP. BURKE, CHAIR: I SAID AT THE TIME THAT RULE HAS BEEN -- 

2 AND WE'RE NOT GOING TO HAVE ANYONE SPEAKING OUT IN THE 

3 MEETING. ALL RIGHT. YOU HAVE OTHER ITEMS? 

4

5 SUP. ANTONOVICH: YEAH 56-B, DON HAD HELD THAT. THIS IS GOING 

6 TO BE DISCUSSED IN EXECUTIVE SESSION. THAT'S THE CHILD THAT 

7 WAS KILLED. 

8

9 SUP. KNABE: YEAH I JUST -- BASICALLY WHAT I HAD WAS JUST AN 

10 AMENDMENT, BECAUSE I FELT YOUR MOTION JUST WAS TO THIS 

11 PARTICULAR ITEM, BUT TO -- HANG ON HERE. I'LL GET MY MOTION. 

12

13 SUP. BURKE, CHAIR: ALL RIGHT. WE HAVE TWO PEOPLE WHO SIGNED UP 

14 TO SPEAK. YVONNE MICHELLE AUTRY AND WARREN WILLIAMS, AND ALL 

15 OF THE ITEMS THEY'VE SIGNED UP FOR WILL BE HEARD UNDER THIS 

16 ITEM. 

17

18 SUP. KNABE: ANYWAY MY AMENDMENT WAS BASICALLY TO REINSTATE THE 

19 POLICY OF PROVIDING THE BOARD AND THE OFFICE OF CHILDREN 

20 SERVICES INSPECTOR GENERAL WITH PROVIDE REGULAR UPDATES ON THE 

21 IMPLEMENTATION, THE BOARD APPROVE INSPECTOR GENERAL 

22 RECOMMENDATION. JUST YOUR MOTION WAS TO THIS SPECIFIC CASE, 

23 AND WHAT I'M ASKING IS WE REINSTITUTE THAT. 

24

25 SUP. BURKE, CHAIR: DO YOU ACCEPT THAT AMENDMENT? 
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1

2 SUP. ANTONOVICH: THAT'S FINE. I ACCEPT THAT. 

3

4 SUP. BURKE, CHAIR: OKAY. HE ACCEPTS THAT AMENDMENT. PLEASE 

5 STATE YOUR NAME. 

6

7 WARREN WILLIAMS: MY NAME IS WARREN WILLIAMS, AND I'M 

8 REPRESENTING THE FOUNDATION TO END INSTITUTIONAL ABUSE OF 

9 CHILDREN, FATHERS, PARENTS, COMMUNITIES, FAMILIES. 

10

11 SUP. BURKE, CHAIR: AND SO WE'RE ALSO CALLING 20 AT THIS TIME 

12 ALSO. 

13

14 WARREN WILLIAMS: YES. AND THE ITEM THAT WE'RE SPEAKING ON IS 

15 56-B, WAS THAT THE ITEM SUPERVISOR BURKE? 

16

17 SUP. BURKE, CHAIR: AND 20. 

18

19 WARREN WILLIAMS: OKAY. I JUST WANTED TO BE CERTAIN. WELL, ON 

20 56-B, WE HAVE THE DEATH, THE DEATH, THE DEATH OF ANOTHER CHILD 

21 THAT THE COUNTY IS ONCE AGAIN RESPONSIBLE FOR. AND I KNOW THAT 

22 THAT'S NOTHING TO LOOK UP ABOUT, NOTHING THIS COUNTY HAD 

23 DEMONSTRATED IT'S SERIOUS ABOUT, AND JUST SOMETHING THE COUNTY 

24 CONTINUES TO DO, AND TO EXCUSE ITSELF AS IT CONTINUES TO KILL, 

25 KILL AND MURDER CHILDREN IN MULTIPLE, MULTIPLE FORMS AND WAYS. 
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1 THIS IS A HOMICIDE. WE'RE DRUGGING OUR CHILDREN AND THE OTHER 

2 THINGS THAT YOU CONTINUE TO DO AND TAKE THEM AWAY FROM THEIR 

3 PARENTS WRONGLY IS ANOTHER WAY OF KILLING A CHILD. THIS IS A 

4 LONGER PROCESS OF SUFFERING. THE OTHER ITEM IS ITEM 20. THAT 

5 HAS TO DO WITH THIS ALLEGED NEW PROCESS OF GETTING CONTROL OF 

6 FUNDS THAT YOU'RE ALLEGING IS TO ENABLE YOU TO HELP KEEP 

7 CHILDREN IN FAMILIES, BUT A FLAWED AND BROKEN AND CORRUPT 

8 SYSTEM HAS DEMONSTRATED FOR TOO LONG THAT YOU HAVE NO 

9 INTENTIONS OF DOING THAT, AND SINCE I HAVE PERSONAL EXPERIENCE 

10 OF WHAT YOU'VE DONE, OF WASTING FUNDS WITH ALLEGED FAMILY 

11 PRESERVATION, OF PROVIDING CORRUPT ATTORNEYS TO SUPPRESS AND 

12 COVER UP EVIDENCE, OF PLACING CHILDREN IN CENTERS LIKE 

13 CHILDREN'S INSTITUTE INTERNATIONAL DID NOT ALLOW FOR THE 

14 FATHER EVEN TO TAKE PART IN THOSE SERVICES. WHEN THE POLICY OF 

15 D.C.S.F. IS TO PROVIDE SERVICES EVEN WITHOUT FILING A 

16 PETITION. IN OTHER WORDS, EVEN WITHOUT STIGMATIZING THE 

17 FAMILY, YOU SHOULD BE PROVIDING THOSE SERVICES. THANK YOU, 

18 SUPERVISOR MOLINA, FOR PAYING ATTENTION. WE'RE ONLY ASKING 

19 THAT THIS COUNTY WILL RESPONSIBLY -- LET ME ASK THIS COUNTY BE 

20 RESPONSIBLE? I'M GLAD THAT THEN SHE'S CHANGED HER POSITION AND 

21 WALKED OUT. THAT'S A BETTER THING TO DO, MOLINA, AND I 

22 CONGRATULATE YOU FOR THAT, BECAUSE YOU GUYS HAVE MURDERED 

23 ANOTHER CHILD, YOU HAVE ABUSED MY CHILD, AND I'M A WITNESS OF 

24 WHAT YOU HAVE DONE, AND I HAVE EVIDENCE TO PROVE IT, THAT YOU 

25 HAVE DONE IT. SO, SEE, I'M NOT TALKING ABOUT WHAT COULD BE OR 
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1 HEARSAY, I'M TALKING ABOUT MY OWN VICTIMIZATION OF THE FRAUD 

2 AND THE WRONGDOING THAT HAS OCCURRED. THIS CHILD CAN'T SPEAK 

3 FOR ITSELF, FOR THE CHILD ANYMORE. 

4

5 SUP. BURKE, CHAIR: ALL RIGHT. THANK YOU. YOUR TIME HAS 

6 EXPIRED. 

7

8 WARREN WILLIAMS: SO I'M ASKING YOU NOT TO FUND THIS AND I'M 

9 ALSO ASKING YOU TO STOP KILLING OUR CHILDREN. 

10

11 SUP. BURKE, CHAIR: YES, STATE YOUR NAME, PLEASE. 

12

13 YVONNE MICHELLE AUTRY: MY NAME IS YVONNE MICHELLE AUTRY, AND 

14 JUST FOR THE RECORD, I'D LIKE TO SUPPORT WHAT GENEVIEVE 

15 CLAVREUL, AND ALSO MY COLLEAGUE, MERRITT HOLLOWAY. I'M 

16 REFERRING TO ITEM 56-B, AND IN ADDRESSING THAT ITEM, I THINK 

17 THE GREATER MOCKERY IS THE FARCE THAT YOU PEOPLE PRETEND TO 

18 REPRESENT EVERY DAY. DO YOU KNOW THAT YOUR JOB IS TO LISTEN TO 

19 AND TO ADDRESS OUR CONCERNS? THAT IS YOUR JOB. I FOUND THAT 

20 OUT. AND THAT IS WHAT YOU'RE SUPPOSED TO DO. THAT IS WHAT 

21 YOU'RE PAID VERY WELL TO DO. AND AT THE BEGINNING OF THIS 

22 MEETING, YOUR SECURITY GUARD HAD INFORMED ME THAT IF I'M OUT 

23 OF ORDER, I WILL BE REMOVED AND INCARCERATED. I'M AN HONOR 

24 STUDENT, I SPEAK, READ, AND WRITE FIVE LANGUAGES, I HAVE NO 

25 CRIMINAL RECORD, SO PLEASE DO ARREST ME, BECAUSE I DID NOT 
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1 VIOLATE THE LAW, AND IT WILL BE COMPLETELY EXPOSED YOUR 

2 CRIMINALITY AND HOW YOU'RE TRYING TO DIVERT ATTENTION FROM 

3 YOUR CORRUPTION BY FALSELY ACCUSING ME OF BEING CRAZY, OUT OF 

4 ORDER, SUBVERSIVE, COMMUNIST OR WHATEVER ELSE MR. ZEV 

5 YAROSLAVSKY INSINUATED LAST WEEK. BY THE WAY, HE WAS OUT OF 

6 ORDER. I HAVE A PETITION FOR HIS EXPULSION AND HIS REMOVAL 

7 WHICH I'D LIKE TO SUBMIT FOR YOUR CONSIDERATION, ESPECIALLY 

8 FOR YOU, MR. LLOYD PELLMAN, BECAUSE HE VIOLATED SECTION 10-A 

9 OF THE RULES OF THE BOARD. HIS JOB IS TO LISTEN, AND I WAS 

10 REFERRING TO AN ITEM THAT WAS ON THE AGENDA. SO HE WAS IN 

11 VIOLATION AND YOUR SECURITY GUARD SAID NOTHING TO ADMONISH, 

12 CENSURE OR REPRIMAND MR. ZEV YAROSLAVSKY. HE WAS OUT OF ORDER. 

13 THERE WILL BE SOME TYPE OF JUSTICE SERVED, AND WE WILL MAKE 

14 SURE OF IT, AND I WILL APPEAR EVERY WEEK UNTIL THAT HAPPENS. I 

15 HAVE EVERY RIGHT, I'M A CITIZEN. I'M NOT GETTING PAID TO BE 

16 HERE. IF THE PEOPLE IN YOUR EMPLOY HAD NOT FORCIBLY OR HAD NOT 

17 ILLEGALLY DETAINED MY SON, MY ONLY CHILD, I WOULD NOT HAVE TO 

18 COME HERE AND WASTE MY TIME EVERY WEEK! SO IF YOU WANT TO 

19 INCARCERATE ME, DO IT, BECAUSE IT WILL BE EXPOSED! LIKE MY 

20 COLLEAGUE SAID, CHILDREN ARE DYING, THEY'RE DYING, THEY'RE 

21 BEING HUNG. I HAVE A FRIEND, HER SON WAS HUNG WHILE IN CHILD 

22 PROTECTIVE CUSTODY, A YOUNG BLACK CHILD. ANOTHER CHILD WAS 

23 OVERMEDICATED, AND SO ANOTHER CHILD WAS RAPED, CHILDREN ARE 

24 BEATEN TO DEATH. YOU THINK BY DIVERTING ATTENTION AND TRYING 

25 TO INCRIMINATE ME THAT PEOPLE WILL NOT KNOW AND YOU WILL NOT 
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1 BE EXPOSED BECAUSE THESE PEOPLE ARE IN YOUR EMPLOY. MR. ZEV 

2 YAROSLAVSKY OWNS EDELMAN, SO HE'S RESPONSIBLE FOR THE JUDGES 

3 AND THE ATTORNEYS AND THE SOCIAL WORKERS. THE SOCIAL WORKERS 

4 ARE DIRECTLY IN YOUR JURISDICTION. YES, YOU, SUPERVISOR BURKE, 

5 AND ALL OF YOU. SO YOU ARE RESPONSIBLE, AND YOU WILL HEAR 

6 EVERY WEEK UNTIL YOU RETURN OUR CHILDREN, INVESTIGATE THE 

7 MURDERS AND STOP THEM! AND IF YOU DON'T WANT TO HEAR IT, DO 

8 SOMETHING ABOUT IT! GO AHEAD. ARREST ME. I AM NOT IN VIOLATION 

9 OF ANY LAW. 

10

11 SUP. BURKE, CHAIR: YOUR TIME HAS EXPIRED. 

12

13 YVONNE MICHELLE AUTRY: THANK YOU. 

14

15 SUP. BURKE, CHAIR: THANK YOU. 

16

17 YVONNE MICHELLE AUTRY: PLEASE DO INVESTIGATE AND STOP THE 

18 ABUSES OF OUR CHILDREN! 

19

20 SUP. BURKE, CHAIR: MOVED BY KNABE -- BY ANTONOVICH ON 56, 

21 MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO 

22 ORDERED. ON ITEM 20, MOVED BY YAROSLAVSKY, SECONDED -- OH, 

23 SOME OTHER SPEAKERS ON 20? ALL RIGHT. ON 56, SO ORDERED. ON 

24 20, THERE ARE TWO OTHER SPEAKERS. AND SUPERVISOR KNABE WAS 
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1 ALSO HOLDING IT. COULD VIRGINIA WELLS, PUBLIC COUNSEL, AND 

2 MICHAEL JEFFRIES, COME FORWARD. 

3

4 VIRGINIA WEISS: HELLO. MY NAME IS VIRGINIA WEISS FROM PUBLIC 

5 COUNSEL, I'M THE DIRECTING ATTORNEY OF THE CHILDREN'S RIGHTS 

6 PROJECT, AND I'M HERE TO SPEAK IN BEHALF OF THE TITLE 4-E 

7 WAIVER PROPOSAL THAT'S BEEN PROPOSED BY DR. SANDERS FROM 

8 D.C.F.S. I THINK IT'S A VERY INNOVATIVE PROPOSAL. WHAT IT WILL 

9 DO IS TO HELP IMPLEMENT THE FEDERAL ADOPTION ASSISTANCE AND 

10 CHILD WELFARE ACT OF 1980, WHICH HAS REQUIRED FOR OVER 20 

11 YEARS THAT THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES MAKE 

12 REASONABLE EFFORTS TO PROVIDE SERVICES TO KEEP THE CHILDREN IN 

13 THE HOME, BUT IRONICALLY, THE FEDERAL MANDATE HAS NOT PROVIDED 

14 FUNDS TO DO THAT. THIS INNOVATIVE APPROACH THAT DR. SANDERS IS 

15 REQUESTING WILL ALLOW FUNDS TO BE PROVIDED SO THAT SERVICES 

16 CAN BE GIVEN TO THE FAMILIES TO KEEP THEM TOGETHER SO THERE 

17 WILL BE NO NEED FOR THE CHILDREN TO BE RIPPED OUT AND PLACED 

18 IN FOSTER CARE AND THEN LIVE IN SEVERAL FOSTER HOMES, POSSIBLY 

19 GROUP HOMES, GO TO DIFFERENT SCHOOLS, UNDERGO A LOT OF MENTAL 

20 HEALTH TRAUMA BEFORE THEIR RETURN TO THEIR HOME, WHICH IS WHAT 

21 HAPPENS TO MOST OF THE CHILDREN. SO PUBLIC COUNSEL, IN ITS 

22 MANY YEARS OF EXPERIENCE IN REPRESENTING CHILDREN, STRONGLY 

23 SUPPORTS THIS REQUEST FOR A TITLE 4-E WAIVER. 

24

25 SUP. BURKE, CHAIR: 
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1

2 VIRGINIA WEISS: THANK YOU. 

3

4 SUP. BURKE, CHAIR: STATE YOUR NAME, PLEASE. 

5

6 MIRIAM CRINSKEY: GOOD MORNING. MY NAME IS MIRIAM CRINSKEY, AND 

7 I'M THE EXECUTIVE DIRECTOR OF THE CHILDREN'S LAW CENTER. OUR 

8 ORGANIZATION REPRESENTS OVER 20,000 YOUTH IN FOSTER CARE, AND 

9 WE, TOO, ARE HERE TO SPEAK ON BEHALF OF AND IN SUPPORT OF ITEM 

10 NUMBER 20. THERE IS NO DOUBT BUT THAT WE HAVE TREMENDOUS, 

11 TREMENDOUS CHALLENGES IN MOVING OUR SYSTEM IN A DIRECTION THAT 

12 WE ALL SHARE IN LOS ANGELES. THERE ARE TOO MANY CHILDREN AND 

13 TOO MANY FAMILIES THAT WE BRING UNDER THE JURISDICTION OF OUR 

14 COURTS SIMPLY TO GET ASSISTANCE TO THEM, AND WE'RE AT A MOMENT 

15 IN TIME WHERE BOTH EXTERNAL PRESSURES ON A FEDERAL AND STATE-

16 WIDE LEVEL AS WELL AS POSITIVE DIRECTIONS ARE, TOGETHER, 

17 CAUSING EVERYBODY TO AGREE THAT WE NEED TO CREATE THE 

18 FLEXIBILITY WITHIN OUR SYSTEM TO MOVE FORWARD ON THE COMMON 

19 GOAL OF PROVIDING ASSISTANCE TO CHILDREN AND FAMILIES IN LOS 

20 ANGELES. WE DON'T DO ENOUGH TO LOOK AT HOW WE CAN GIVE 

21 ASSISTANCE TO FAMILIES IN NEED AND CHILDREN IN NEED, AND 

22 FLEXIBLE FUNDING IS A CRITICAL INGREDIENT OF FORWARD MOTION. 

23 THERE SHOULD NOT BE FINANCIAL DISINCENTIVES THAT CAUSE US TO 

24 REMOVE CHILDREN FROM HOMES AND TO KEEP THEM WITHIN THE 

25 JURISDICTION OF OUR SYSTEM SIMPLY TO GET THEM HELP. THE 
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1 INNOVATIVE APPROACH THAT DR. SANDERS AND HIS LEADERSHIP TEAM 

2 AT D.C.F.S. HAVE PUT TOGETHER WILL GIVE LOS ANGELES THE GREEN 

3 LIGHT FOR THE FIRST TIME TO TRULY INNOVATE. THE ADVOCACY 

4 COMMUNITY, THE CHILDREN'S LAW CENTER ARE SUPPORTIVE OF THAT 

5 DIRECTION. WE COMMEND THE BOARD FOR JOINING AND URGE YOU TO 

6 FORMALLY JOIN IN MOVING FORWARD IN THIS DIRECTION AND ARE 

7 WILLING AND COMMITTED TO BEING A PART OF ASSISTING AS THIS 

8 MOVES FORWARD. 

9

10 SUP. BURKE, CHAIR: THANK YOU. 

11

12 TONY BRAVO: MY NAME IS TONY BRAVO, I'M A PRESIDENT OF A LOCAL 

13 535. I'M ALSO A SUPERVISING CHILDREN'S SOCIAL WORKER WITH THE 

14 DEPARTMENT OF CHILDREN AND FAMILY SERVICES. I'VE BEEN EMPLOYED 

15 BY THE DEPARTMENT FOR 23 YEARS, AND IN MY TIME WITH THE 

16 DEPARTMENT, I THINK I'VE OBSERVED THAT WE HAVE FAR TOO MANY 

17 CHILDREN THAT COME INTO OUR SYSTEM AND STAY FAR TOO LONG. WE 

18 FEEL THAT THIS INITIATIVE HERE IS A BOLD AND INNOVATIVE 

19 CONCEPT THAT WILL PROVIDE A WIN-WIN SITUATION FOR CLIENTS, 

20 MANAGEMENT, LABOR, AND THE BOARD OF SUPERVISORS. BY SHIFTING 

21 FUNDS TO COMMUNITY RESOURCES, IT WILL RESULT IN A REDUCTION OF 

22 CASES THAT COME INTO THE SYSTEM, AND LOWERING THE CASELOAD SO 

23 THAT CHILDREN'S SOCIAL WORKERS HAVE MORE TIME TO VISIT WITH 

24 THEIR FAMILIES AND THEIR CHILDREN. AND HENCE, YOU WILL HAVE 

25 IMPROVED OUTCOMES FOR THESE FAMILIES. AND BY REDUCING 
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1 CASELOADS, YOU WILL ALSO BE ABLE TO HAVE MORE EFFECTIVE 

2 CONCURRENT PLANNING, WHICH WILL ALSO INCREASE FAMILY 

3 REUNIFICATION AND DECREASE THE TIME THAT CHILDREN SPEND IN 

4 GETTING TO PERMANENCY. AND, IN FACT, WITH AN INFECTIVE 

5 CONCURRENT PLANNING, IT CAN REDUCE THE AMOUNT OF LITIGATION 

6 AND FINANCIAL LIABILITY FOR LOS ANGELES COUNTY WHEN DECISIONS 

7 ARE MADE UP FRONT AND THEY ARE THE PROPER DECISIONS AND 

8 HOPEFULLY IT CAN RESULT IN REDUCING THE NUMBER OF CHILDREN 

9 THAT COME INTO THIS SYSTEM. SO WE ENCOURAGE YOU, BOARD OF 

10 SUPERVISORS, TO PLEASE SUPPORT DR. SANDERS IN THIS INITIATIVE. 

11 THANK YOU. 

12

13 SUP. BURKE, CHAIR: THANK YOU VERY MUCH. SUPERVISOR KNABE. 

14

15 SUP. ANTONOVICH: LET ME ASK, JUST TO ADD, IF WE COULD HAVE THE 

16 BOARD LETTER SUPPORT THIS BUT REQUEST THAT THE DEPARTMENT WORK 

17 WITH COMMUNITY AGENCIES, INCLUDING CHILDREN'S LAW CENTER AND 

18 THE A.C.H.S.A. TO HELP DEVELOP THE WAIVER REQUEST. 

19

20 SUP. KNABE: OKAY AND I --MINE WAS JUST GOING TO BE BECAUSE OF 

21 THE PHYSICAL UNCERTAINTIES WE'RE DEALING WITH AT BOTH THE 

22 STATE AND FEDERAL LEVELS, THAT I WOULD MOVE THAT THE DIRECTOR 

23 OF THE CHILDREN AND FAMILY SERVICES, IN CONJUNCTION WITH THE 

24 C.A.O., PROVIDE ONGOING STATUS TO OUR BOARD ON THE 

25 NEGOTIATIONS WITH THE CALIFORNIA DEPARTMENT OF SOCIAL SERVICES 
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1 AND THE FEDERAL DEPARTMENT OF HEALTH SERVICES, AND THAT PRIOR 

2 TO ANY FINAL AGREEMENT, THAT WE BE APPRISED OF THE TERMS AND 

3 SAFEGUARDS THAT ARE IN PLACE. 

4

5 SUP. BURKE, CHAIR: OKAY. MOVED BY KNABE, SECONDED BY 

6 ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

7

8 SUP. KNABE: AS AMENDED. RIGHT? 

9

10 SUP. BURKE, CHAIR: AS AMENDED. 

11

12 SUP. ANTONOVICH: NUMBER 22. 

13

14 SUP. BURKE, CHAIR: HAS ANYONE ASKED TO SPEAK ON THAT ITEM? 

15

16 SUP. ANTONOVICH: MS. MOLINA HAS AN AMENDMENT ON 22. 

17

18 SUP. MOLINA: YES, ON ITEM NUMBER 22, I DO, AND I'M GOING TO 

19 HAVE MY STAFF -- 

20

21 SUP. BURKE, CHAIR: WELL PETER BAXTER I THINK HAS ASKED TO 

22 SPEAK. MR. BAXTER AS YOU'RE COMING UP, SUPERVISOR MOLINA WILL 

23 READ HER AMENDMENT. 

24
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1 SUP. MOLINA: ALL RIGHT. LAST YEAR THE BOARD INSTRUCTED THE 

2 AUDITOR-CONTROLLER TO ESTABLISH MEASURE B WHICH OVERSIGHT 

3 COMMITTEE TO MONITOR THE COLLECTION AND EXPENDITURE OF MEASURE 

4 B FUNDS. IN JUNE, THE AUDITOR-CONTROLLER REPORTED ON THE 

5 STRUCTURE OF THE OVERSIGHT COMMITTEE AND THE RESPONSIBILITIES 

6 OF PARTICIPATING COUNTY DEPARTMENTS. SPECIFICALLY, THE 

7 AUDITOR-CONTROLLER'S MEMO STATED THE DEPARTMENT OF HEALTH 

8 SERVICES IS RESPONSIBLE FOR AUTHORIZING AND RECOMMENDING FOR 

9 BOARD APPROVAL THE DISBURSEMENT OF MEASURE B FUNDS TO MEET 

10 TRAUMA, BIO-TERRORISM NEEDS AND BIO-TERRORISM NEEDS IN THE 

11 COUNTY. GIVEN THE RECENT CONFUSION OVER THE FIRE DEPARTMENT'S 

12 REQUEST TO OBTAIN A HELICOPTER FOR THE TRANSPORT OF TRAUMA 

13 PATIENTS FROM THE ANTELOPE VALLEY AND THE NEED TO ENSURE THAT 

14 THESE FUNDS ARE SPENT IN ACCORDANCE WITH THE INTENT OF MEASURE 

15 B, IT IS IMPORTANT TO CLARIFY THE ROLE THAT THE DEPARTMENT OF 

16 HEALTH SERVICES PLAYS IN THE PROCESS. I THEREFORE MOVE THAT 

17 PRIOR TO THE SUBMISSION TO THE BOARD OF SUPERVISORS ALL 

18 RECOMMENDATIONS OR EXPENDITURE OF MEASURE B FUNDS OBTAIN 

19 CONCURRENCE FROM THE DEPARTMENT OF HEALTH SERVICES AND THAT 

20 THAT SUCH CONCURRENCE IS DOCUMENTED IN THE BOARD LETTER. 

21 THAT'S MY MOTION MADAM CHAIR. 

22

23 SUP. BURKE, CHAIR: IS THAT ACCEPTED? 

24

25 SUP. ANTONOVICH: YEAH THAT'S -- 
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1

2 SUP. BURKE, CHAIR: RIGHT. MOVED BY -- I'M SORRY, MR. BAXTER. 

3

4 SUP ANTONOVICH: MR. BAXTER WANTS TO SPEAK. 

5

6 SUP. BURKE, CHAIR: PLEASE STATE YOUR NAME. 

7

8 PETER BAXTER: MADAM CHAIR, MEMBERS OF YOUR HONORABLE BOARD, 

9 MR. JANSSEN, LADIES AND GENTLEMEN, MY NAME IS PETER BAXTER, 

10 AND I LIVE IN LOS ANGELES. IT IS RESPECTFULLY SUBMITTED THAT 

11 THIS AGENDA ITEM INITIATES THE PURCHASE OF A WATER-DROPPING 

12 HELICOPTER FOR FIGHTING FOREST FIRES. WATER AS A MEANS OF FIRE 

13 SUPPRESSION IS THE ONLY MEANS WE USE. SUCH A METHOD IS 

14 CHARACTERIZED BY FAILURE YEAR AFTER YEAR AFTER YEAR. AT THE 

15 BOARD MEETING LAST WEEK, THE CHAIR KINDLY ACCEPTED A COPY OF 

16 IMAX CORPORATION'S VIDEO ENTITLED 'FIRES OF KUWAIT' FROM ME. 

17 THAT VIDEO SHOWS AN OIL WELL FIRE BEING PUT OUT IN 1991, IN 

18 KUWAIT, BY THE EMISSIONS FROM THE TWO TURBO JET ENGINES IN A 

19 TOTAL OF NINE SECONDS. THAT FIRE HAD BEEN BURNING FOR ABOUT 

20 SIX MONTHS. FOR ANY FIRE UNDER FIRE SUPPRESSION BY WATER -- BY 

21 WATER MEANS, TO BE PUT OUT IN NINE SECONDS WOULD BE AMAZING. 

22 THAT OIL WELL FIRE IN KUWAIT, GOING OUT IN NINE SECONDS WAS 

23 NOT AMAZING BY THE STANDARD OF DENYING FIRE OXYGEN. THAT FIRE 

24 ACTUALLY WENT OUT IN LESS THAN ONE SECOND. ALL FIRES GO OUT IN 

25 LESS THAN ONE SECOND WHEN DENIED OXYGEN. THAT IS STANDARD. TO 
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1 SET IN MOTION THE PURCHASE OF A HELICOPTER IS TO DENY THE 

2 EVIDENCE OF THE VIDEO BY IMAX WHICH DEMONSTRATES THE USE OF 

3 NONCOMBUSTIBLE GASSES TO PUT OUT FIRE, ALL OF WHICH IS 

4 RESPECTFULLY SUBMITTED. I THANK YOU, MADAM CHAIR. 

5

6 SUP. ANTONOVICH: MOVE THE ITEM AS AMENDED. 

7

8 SUP. BURKE, CHAIR: MOVED BY ANTONOVICH -- 

9

10 SUP. YAROSLAVSKY: ONE SECOND, I JUST WANT TO BE SURE, MR. 

11 JANSSEN. I DON'T KNOW IF YOU'RE FOLLOWING THIS OR -- DEPENDS 

12 ON THE QUESTION. IS ONE OF THE THINGS I ASSUME THAT'S IMPLIED 

13 IN MS. MOLINA'S MOTION, BUT I WANT TO MAKE SURE THAT WE GET 

14 THE -- THERE WERE TWO ISSUES, THERE WERE TWO GEOGRAPHIES, THE 

15 ANTELOPE VALLEY AND THE EASTERN SAN GABRIEL VALLEY AREA THAT 

16 WERE SUPPOSED TO BE -- THAT WAS OUR GOAL TO COVER, AND IS THAT 

17 WHAT YOU'RE HOPING TO BE ADDRESSED IN YOUR MOTION, OR IS THAT 

18 SEPARATE? THAT'S SEPARATE FROM THAT? 

19

20 SUP. MOLINA: NO. THE MOTION IS BASICALLY JUST CREATING A 

21 PROCESS TO MAKE SURE THE DEPARTMENT OF HEALTH SERVICES HAS 

22 CONCURRENCE WITH THESE ITEMS. THAT'S ALL. 

23

24 SUP. YAROSLAVSKY: I JUST WANT TO -- THAT'S FINE, AND I AGREE 

25 WITH THAT TOTALLY. I JUST WANT TO BE SURE, IN ADDITION TO 
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1 THAT, THAT THE ISSUE OF WHERE THE MONEY -- HOW THE MONEY IS 

2 GOING TO BE SPENT AND WHAT SERVICE WE'RE PURCHASING FOR THE 

3 MONEY, WHEN THAT COMES BACK TO US, WHERE THAT SERVICE IS GOING 

4 TO BE PROVIDED BEFORE WE MAKE ANY COMMITMENT TO SPENDING THAT 

5 MONEY. IS THAT -- THIS ACTION TODAY IS NOT A COMMITMENT TO 

6 SPENDING THE MONEY? 

7

8 C.A.O. JANSSEN: THAT'S CORRECT. IT'S JUST TO NOTIFY, GIVE THEM 

9 A ONE-YEAR NOTICE. IT CAN BE REVOKED, RIGHT. 

10

11 SUP. YAROSLAVSKY: CANCELED OKAY. SO LET'S JE BE SURE -- 

12

13 C.A.O. JANSSEN: THAT THAT IS INCLUDED IN -- 

14

15 SUP. YAROSLAVSKY: -- THAT THE NEXT TIME THIS COMES FORWARD 

16 THAT WE ADDRESS THE SAN GABRIEL VALLEY ISSUE AND THE ANTELOPE 

17 VALLEY ISSUE, WHICH WERE THE TWO IN MEASURE B THAT WE WERE -- 

18 I BELIEVE THOSE WERE THE ONLY TWO THAT WE -- YEAH. THERE WAS 

19 POMONA VALLEY. I THINK THAT WAS ONE OF THEM, THE EASTERN -- 

20

21 C.A.O. JANSSEN: POMONA, EASTERN SAN GABRIEL VALLEY, AND 

22 ANTELOPE VALLEY, RIGHT. 

23

24 SUP. YAROSLAVSKY: SAN GABRIEL VALLEY AND THE ANTELOPE YEAH. 

25 OKAY SO LET'S MAKE SURE THAT'S ADDRESSED. THANK YOU. 
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1

2 SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT 

3 OBJECTION, SO ORDERED. 

4

5 SUP. ANTONOVICH: 55. 

6

7 SUP. BURKE, CHAIR: THIS IS A HEARING. IS THERE ANY STAFF TO? 

8

9 C.A.O. JANSSEN: MADAM CHAIR, THIS IS THE DISTRIBUTION OF THE 

10 C.O.P.S. MONEY. IT HAS BEEN CONTINUED A NUMBER OF TIMES BEFORE 

11 THE BOARD. THERE'S NOBODY HERE FROM THE PUBLIC TO TESTIFY ON 

12 IT. WE RECOMMEND YOU APPROVE IT. 

13

14 SUP. ANTONOVICH: MOVE THE ITEM. 

15

16 SUP. BURKE, CHAIR: IT'S BEEN MOVED THAT THE HEARING BE CLOSED 

17 BY ANTONOVICH, SECONDED BY KNABE. AND THAT THE ITEM BE 

18 APPROVED. WITHOUT OBJECTION, SO ORDERED. 

19

20 SUP. ANTONOVICH: THAT'S ALL I HAD, MADAM CHAIR. 

21

22 SUP. BURKE, CHAIR: SUPERVISOR MOLINA. 

23

24 SUP. MOLINA: MADAM CHAIR, I HAVE TWO ADJOURNMENTS. FIRST OF 

25 ALL, I'D LIKE TO ASK THAT WE ADJOURN IN THE MEMORY OF ARMY 
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1 SPECIALIST, JOSE ALMORA. HE WAS KILLED IN ACTION WHILE SERVING 

2 OUR COUNTRY IN IRAQ. MR. ALMORA WAS A NATIVE OF THE CITY OF 

3 BELL AND A 1995 BELL HIGH SCHOOL GRADUATE. WE WANT TO EXTEND 

4 OUR DEEPEST CONDOLENCES TO HIS PARENTS, HIS WIFE, AND HIS 

5 CHILDREN. 

6

7 SUP. BURKE, CHAIR: SO ORDERED. 

8

9 SUP. MOLINA: I'D ALSO LIKE TO ASK THAT WE ADJOURN IN THE 

10 MEMORY OF SELINDA ANA BENYA HO, SELINDA WAS THE COUSIN OF 

11 CARMEN GARCIA WHO'S A DEAR FRIEND OF OUR OFFICE. WE WANT TO 

12 EXTEND OUR DEEPEST CONDOLENCES TO THEIR FAMILY AS WELL. 

13

14 SUP. BURKE, CHAIR: SO ORDERED. 

15

16 SUP. MOLINA: THOSE ARE THE ONLY ITEMS I HAD. 

17

18 SUP. BURKE, CHAIR: I MOVE THAT WHEN WE ADJOURN TODAY, WE 

19 ADJOURN IN MEMORY OF RONALD COLEMAN -- ROLAND COLEMAN SR., WHO 

20 PASSED AWAY ON SUNDAY, NOVEMBER 2ND. HE'S THE FATHER OF 

21 ATTORNEY ROLAND COLEMAN JR., A PARTNER AT WILSON EISER, AND 

22 FORMER PRESIDENT OF LANGSTON BAR ASSOCIATION. AND RONALD LEE 

23 BURTON WHO PASSED AWAY SUDDENLY ON NOVEMBER 4TH AT THE AGE OF 

24 53. HE WAS A LONG-TIME RESIDENT OF THE CITY OF COMPTON. AND 

25 DEPUTY PUBLIC CONSERVATOR ADMINISTRATOR ONE WITH THE 
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1 DEPARTMENT OF TREASURER AND TAX COLLECTOR. HE WAS A 34 YEAR 

2 LOS ANGELES COUNTY EMPLOYEE, SURVIVED BY HIS WIFE, TONY BURTON 

3 AND A DAUGHTER, DANA BURTON. AND ANITA LOGO HILL, WHO PASSED 

4 AWAY IN HER SLEEP AT THE AGE OF 77 TWO DAYS AGO. SHE WAS A 

5 MAJOR FIGURE IN SOUTHERN CALIFORNIA'S CIVIL RIGHTS COMMUNITY 

6 AS A LIFETIME BOARD MEMBER OF THE CALIFORNIA COMMERCE OF 

7 RACIAL EQUALITY AND A SOUGHT-AFTER SPEAKER WHO WAS ALSO A 

8 STALWART IN THE CALIFORNIA REPUBLICAN PARTY POLITICS THAT SHE 

9 CHARACTERISTICALLY APPROACHED FROM HER UNIQUE MULTI-RACIAL 

10 VANTAGE POINT. SHE WAS A DESCENDENT OF THE MEXICAN GOVERNOR OF 

11 CALIFORNIA PIO PICO AND A DESCENDANT OF THE LEGENDARY AFRICAN-

12 AMERICAN ARCHITECT, PAUL WILLIAMS. SHE WAS ALSO THE WOMAN 

13 BEHIND BRIGADIER GENERAL CELESTE KING THE 3RD FOR 62 YEARS. HE 

14 PRECEDED HER IN DEATH EARLIER THIS YEAR IN APRIL. SHE 

15 CONTINUED WORKING AT KING BAIL BONDS AGENCY, STILL LOCATED IN 

16 THE MIDDLE OF SOUTH CENTRAL LOS ANGELES, WHICH HAS ALSO BECOME 

17 A TRADITIONAL COMMUNITY TOWN HALL. SHE'S SURVIVED BY HER 

18 BUSINESS PARTNER DAUGHTER TERRY KING AND TWO SONS, CELESTE 

19 4TH, MIKE, AND TOBY NELSON, 8 GRANDCHILDREN AND 13 GREAT 

20 GRANDCHILDREN. SHE WAS KNOWN FOR HER PASSIONATE OPINION WHICH 

21 SHE NEVER HELD BACK. HERS WAS A STRONG AND UNRELENTLESS VOICE, 

22 ALWAYS RAISED ON BEHALF OF THE UNDERSERVED. 

23

24 SUP. ANTONOVICH: IS THAT ANITA? 

25
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1 SUP. BURKE, CHAIR: YES. ALL MEMBERS? 

2

3 SUP. ANTONOVICH: PUT ME ON THAT. WHEN DID SHE PASS AWAY? 

4

5 SUP. BURKE, CHAIR: SHE -- SATURDAY. YEAH. 

6

7 SUP. ANTONOVICH: SHE WAS A -- 

8

9 SUP. BURKE, CHAIR: NO I'M SORRY, SHE PASSED AWAY ON MONDAY. 

10

11 SUP. ANTONOVICH: ANITA WAS A VERY ELOQUENT AND WONDERFUL LADY 

12 WHO HAD BEEN DOWN TO THE BOARD MANY TIMES WITH HER HUSBAND 

13 CELESTE. 

14

15 SUP. BURKE, CHAIR: MANY TIMES. 

16

17 SUP. ANTONOVICH: AND IN THE COMMUNITY AT THE NATIONAL 

18 REPUBLICAN CONVENTIONS AS A DELEGATE, AND THAT'S -- SHE WAS A 

19 VERY NICE, NICE LADY. 

20

21 SUP. BURKE, CHAIR: YES, SHE WAS, AND EVEN THOUGH SHE WAS ILL 

22 FOR A WHILE AND SHE WAS IN A WHEELCHAIR, OF COURSE, VERY 

23 RECENTLY, BUT SHE WAS ALWAYS VERY, VERY ACTIVE IN CIVIL RIGHTS 

24 AND ALSO POLITICS OVER THE YEARS. ALL MEMBERS. I HAVE ONE 

25 MOTION TO INTRODUCE, IF I CAN FIND IT. I KNOW THAT IN THE 
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1 CONTINUING DISCUSSION OF THE ISSUE OF KING DREW, WE SAW A 

2 REPORT IN THE NEWSPAPER ABOUT TWO PATIENT DEATHS. WE'VE 

3 ACTUALLY DISCUSSED THIS BEFORE. THIS RELATES TO THE MACHINERY 

4 THAT WAS MONITORING THE TWO PEOPLE WHO UNFORTUNATELY PASSED 

5 AWAY WITHOUT THE MONITORS BEING REPORTED AND PICKING UP THAT 

6 THEY HAD STOPPED BREATHING AND THAT THEY WERE IN -- HAVING 

7 DIFFICULTY. THE STATE INVESTIGATOR CITED THE FAILURE OF 

8 CLINICAL STAFF TO PROPERLY MANAGE THE DELIVERY OF CARE TO THE 

9 TWO PATIENTS AND DETAILED A NUMBER OF CITATIONS AGAINST THE 

10 HOSPITAL. I KNOW THE DEPARTMENT OF HEALTH SERVICES CONDUCTING 

11 ITS OWN INVESTIGATION INTO THE PROBLEMS THAT OCCURRED IN THESE 

12 TWO SITUATIONS AND HAS TAKEN A NUMBER OF CORRECTIVE ACTION IN 

13 THIS MATTER. IT'S IMPORTANT THAT THE BOARD IS FULLY INFORMED 

14 ON THIS MATTER. I THEREFORE MOVE THAT THE BOARD OF SUPERVISORS 

15 INSTRUCT THE DIRECTOR OF HEALTH SERVICES TO REPORT BACK TO THE 

16 BOARD IN CLOSED SESSION ON NOVEMBER 18TH ON THE SPECIFIC 

17 CITATIONS IDENTIFIED IN THE STATE DEPARTMENT OF HEALTH 

18 SERVICES REPORT ON THESE TWO PATIENT DEATHS AND THE ACTIONS 

19 BEING TAKEN TO CORRECT ANY RELATED DEFICIENCIES IN PROVISION 

20 OF CARE AT KING DREW. AND THAT'S A REPORT BACK FOR THE 

21 NOVEMBER 18TH. SO ORDERED -- SECONDED BY KNABE. WITHOUT 

22 OBJECTION, SO ORDERED. AND YAROSLAVSKY. YOU HAVE NO 

23 ADJOURNMENTS? OKAY. 

24
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1 SUP. KNABE: MADAM CHAIR, I HAVE A COUPLE OF ADJOURNMENTS. I 

2 DID, TOO, WANT TO -- ON THE BOBBY HATFIELD ADJOURNMENT, JOIN 

3 IN WITH THAT AS WELL. A COUPLE THINGS. BACK IN 1986, WHEN I 

4 WAS MAYOR OF CERRITOS AND THE CERRITOS AIR CRASH, THE 

5 RIGHTEOUS BROTHERS, BOB AND BILL, RIGHT AFTERWARDS, PUT ON FOR 

6 SOME OF THE SURVIVING FAMILY MEMBERS A VERY SPECIAL EVENT OVER 

7 AT THAT TIME, YOU KNOW, THE HOP THERE IN LAKEWOOD, AND THEY 

8 WERE ALWAYS DOING THINGS LIKE THAT. THEY WERE VERY GRATEFUL 

9 FOR THEIR OPPORTUNITY AND WERE ALWAYS GIVING BACK. BOBBY'S 

10 WIFE HAS LUPUS, AND EACH YEAR, THEY PUT ON A GOLF TOURNAMENT 

11 FOR THE LUPUS FOUNDATION WHERE THEY RAISED SIGNIFICANT DOLLARS 

12 FOR RESEARCH ON LUPUS. AND AS I TELL PEOPLE, IT'S THE ONLY 

13 TOURNAMENT THAT I PLAY IN THAT THERE ARE MORE PEOPLE AT THE 

14 DINNER THAN THE GOLF TOURNAMENT, BECAUSE THEY BRING IN THE 

15 ENTIRE RIGHTEOUS BROTHERS CREW AND THEY DO A CONCERT OUTSIDE 

16 AFTER THE GOLF TOURNAMENT, BUT THEY RAISE AN INCREDIBLE AMOUNT 

17 OF MONEY FOR LUPUS. SO HE'S GOING TO BE MISSED BY ALL. A GREAT 

18 GUY, A FUN GUY, AND OUR HEARTS GO OUT TO THE FAMILY. ALSO THAT 

19 WE ADJOURN IN MEMORY OF MR. DICK WHITE, A LONG-TIME SOUTHERN 

20 CALIFORNIA NEWSMAN AND SPORTS EXECUTIVE WHO PASSED AWAY LAST 

21 WEEK IN SAN PEDRO. HE WORKED FOR THE LOS ANGELES LAKERS AND 

22 KINGS AND WAS THE GENERAL MANAGER OF THE LOS ANGELES SPORTS 

23 ARENA. HE STARTED HIS CAREER IN 'THE SOUTH BAY DAILY BREEZE' 

24 AS SPORTS EDITOR IN THE EARLY '60S, HE LATER MOVED TO SAN 

25 DIEGO WHERE HE WORKED FOR THE SAN DIEGO INTERNATIONAL SPORTS 
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1 ARENA AND THE SAN DIEGO ROCKETS OF THE N.B.A. SURVIVED BY HIS 

2 WIFE, SANDY. ALSO THAT WE ADJOURN IN MEMORY OF ALEX CASTANETA 

3 ANDRES, WHO PASSED AWAY ON AUGUST 20TH. HE WAS -- HE SERVED IN 

4 WORLD WAR II, THE KOREAN WAR AND WAS A SURVIVOR OF THE BATAN 

5 DEATH MARCH AND RECIPIENT OF THE BRONZE STAR. HE ORGANIZED AND 

6 CO-FOUNDED THE FILIPINO AMERICAN POLITICAL ACTION GROUP, THE 

7 AMERICAN EX-PRISONERS OF WAR, THE PHILIPPINE SCOUT HERITAGE 

8 SOCIETY, THE UNITED UNIFIED FIELD AMERICAN SERVICES 

9 ORGANIZATION, AND HE'S A PROUD MEMBER OF THE KNIGHTS OF 

10 COLUMBUS. HE'S SURVIVED BY HIS WIFE OF 63 YEARS, MARGARITA, 

11 SONS, ALAN, DON, CONSTANINO AND FRANCISCO. DAUGHTERS ANNIE, 

12 MARLENE, AND ANITA AND BROTHER, LAREN, 7 GRANDCHILDREN AND 

13 NUMEROUS NIECES AND NEPHEWS. HE WILL BE MISSED BY ALL. HE WAS 

14 A GREAT GUY, A GOOD FRIEND. THOSE ARE MY ADJOURNMENTS. 

15

16 SUP. BURKE, CHAIR: SO ORDERED. 

17

18 SUP. YAROSLAVSKY: MADAM CHAIR? I HAD A MOTION I WANTED TO READ 

19 IN, AND I FORGOT. LET ME JUST READ THE RESOLVE FOR NEXT WEEK. 

20 THIS DEALS WITH SENATE BILL 1630 AND H.R 3111, BOTH KNOWN AS 

21 THE CALLING FOR 2-1-1 ACT OF 2003 WHICH ARE PENDING IN 

22 CONGRESS. BOTH BILLS SEEK TO MAKE THE 2-1-1 TELEPHONE SERVICE 

23 AVAILABLE NATION-WIDE BY PROPOSING TO AWARD FEDERAL GRANTS TO 

24 EACH STATE TO ESTABLISH A 2-1-1 TELEPHONE SERVICE. THE 

25 PROPOSED FEDERAL FUNDS WILL ASSIST IN THE RAPID DEPLOYMENT AND 
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1 MAINTENANCE OF THE 2-1-1 TELEPHONE SERVICE IN LOS ANGELES 

2 COUNTY AND THE STATE OF CALIFORNIA. I THEREFORE MOVE THAT THE 

3 BOARD OF SUPERVISORS SEND A FIVE-SIGNATURE LETTER TO THE L.A. 

4 COUNTY CONGRESSIONAL DELEGATION SUPPORTING S-1630 AND H.R. 

5 3111, AND INSTRUCT THE COUNTY'S FEDERAL LEGISLATIVE ADVOCATES 

6 TO ASSIST WITH THE SUCCESSFUL PASSAGE OF BOTH LEGISLATIVE 

7 BILLS. THIS IS FOR NEXT WEEK. 

8

9 SUP. BURKE, CHAIR: ALL RIGHT. THANK YOU. I'D LIKE TO ALSO HAVE 

10 AN ADDITIONAL MOTION. I RECEIVED A CORRESPONDENCE FROM THE 

11 PETERSON AUTOMOTIVE MUSEUM, AND THEY WOULD LIKE TO HAVE SOME 

12 DISCUSSION ABOUT THE TRANSFER OF THE AUTOMOBILES -- 

13

14 SUP. KNABE: I ALREADY GAVE DAVID MY COPY OF THAT LETTER. 

15

16 SUP. BURKE, CHAIR: SO I WOULD ASK THAT HE REPORT BACK ON THE -

17 - 

18

19 SUP. YAROSLAVSKY: YEAH. I GOT THE SAME LETTER, AND I DID SPEAK 

20 TO JANE PISANO, THE DIRECTOR OF THE NATURAL HISTORY MUSEUM, 

21 'CAUSE THERE'S AN ISSUE THERE SO -- 

22

23 SUP. BURKE, CHAIR: ALL RIGHT. CAN WE GET A REPORT BACK ON 

24 THAT? 

25
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1 SUP. YAROSLAVSKY: HE CAN COORDINATE IT. YEAH, THAT'S A GOOD 

2 IDEA. 

3

4 SUP. BURKE, CHAIR: OKAY. SO IS THERE ANY OBJECTION FOR US TO 

5 JUST FORMERLY ASK FOR A REPORT BACK? ALL RIGHT. IS THERE ANY -

6 - DID YOU HAVE ANYTHING FURTHER? ANY OTHER -- NUMBER 8, WE 

7 HAVE NOT CALLED. I'LL CALL IT UP. AND ONE PERSON HAS ASKED TO 

8 SPEAK ON THAT, ALAN CLAYTON. I'M SORRY. SOMEHOW I THOUGHT THAT 

9 HAD BEEN CALLED UP. I'M SORRY. 

10

11 ALAN CLAYTON: MY NAME IS ALAN CLAYTON, I'M HERE REPRESENTING 

12 THE LOS ANGELES COUNTY CHICANO EMPLOYEES ASSOCIATION, AND I'M 

13 HERE TO SPEAK ON ITEM 8. I'M NOT HERE TO OPPOSE ITEM 8; I'M 

14 HERE TO SUGGEST THAT ITEM 8 IS ONE STEP TO DEAL WITH THE NEED 

15 FOR EQUAL DELIVERY OF SERVICES. BUT THE KEY STEP IS IN 

16 EFFECTIVE RECRUITMENT OF STAFF THAT HAVE THE LANGUAGE SKILLS. 

17 THE PROBLEM I SEE WITH 8 AS STANDING ALONE IS THAT TITLE 6 

18 CLEARLY REQUIRES THAT THE INDIVIDUALS THAT PERFORM THE 

19 SERVICES HAVE THE SKILL LEVEL TO BE ABLE TO COMMUNICATE 

20 EFFECTIVELY, AND THE PROBLEM IS THAT WHEN YOU GIVE A COURSE IN 

21 BASIC SPANISH OR BASIC CHINESE OR TAGALOG OR OTHER LANGUAGES, 

22 OFTENTIMES THEY'LL GET LIMITED COMMUNICATION SKILLS AND MANY 

23 TIMES IT'S FRUSTRATING DEALING WITH THE CLIENTS IN THOSE 

24 LANGUAGES WHERE THE PERSON, ONE, BARELY UNDERSTANDS WHAT 

25 THEY'RE SAYING, AND THEY'RE DEALING WITH ISSUES AND REPORTS 
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1 THAT ARE FAIRLY COMPLEX, HAVING WORKED FOR A COUNTY FOR NINE 

2 NINE-AND-A-HALF YEARS, I KNOW IT'S DIFFICULT ENOUGH IN DEALING 

3 WITH REGULATIONS AND REPORTING WITHOUT HAVING SOMEBODY THAT 

4 JUST KNOWS IT IN A LIMITED FORM. SO WHILE WE DO NOT OPPOSE 

5 BASICALLY TEACHING INDIVIDUALS SPANISH, CANTONESE AND OTHER 

6 LANGUAGES, WHAT WE DO SAY IS YOU NEED TO LOOK AT RECRUITING 

7 INDIVIDUALS THAT HAVE THOSE SKILL LEVELS IN A VARIETY OF 

8 LANGUAGES AND L.A. COUNTY ABOUT 80, 90% OF ITS SPECIFIC NEED 

9 IS IN SPANISH, BUT YOU HAVE SPECIFIC AREAS AND SPECIFIC -- FOR 

10 EXAMPLE, DISTRICT OFFICES WHERE THEY HAVE OTHER NEEDS, FOR 

11 EXAMPLE, IN THE SAN GABRIEL VALLEY, THERE'S A NEED FOR 

12 INDIVIDUALS WITH CHINESE LANGUAGE, IN GLENDALE, ARMENIAN, AND 

13 OTHER AREAS. SO WHILE WE DO, YOU KNOW, OBVIOUSLY WOULD LIKE 

14 ANYTHING THAT WOULD BENEFIT INDIVIDUALS IN TERMS OF EFFECTIVE 

15 COMMUNICATION, WE WOULD LIKE TO ASK THAT YOU ALSO LOOK AT 

16 DEVELOPING EFFECTIVE PLANS THAT WOULD ENSURE THAT YOU HAVE 

17 STAFF THAT BASICALLY ARE FLUENT IN THE LANGUAGE, HAVE PASSED 

18 THE TEST THAT THE COUNTY GIVES, AND CAN OCCUPY POSITIONS WHERE 

19 THEY CAN DEAL EFFECTIVELY. THE OTHER PROBLEM IS WHEN YOU GIVE 

20 INDIVIDUALS JUST THE CONVERSATIONAL ASPECT, OFTENTIMES, 

21 THEY'RE GOING TO GO BACK TO THE EMPLOYEES WHO ACTUALLY DO 

22 UNDERSTAND THE LANGUAGE AND ARE CERTIFIED AND HAVE THE SKILL, 

23 BECAUSE, FRANKLY, THE PROBLEM IS TOO COMPLEX FOR THEM TO DEAL 

24 WITH THAT PATIENT. 'CAUSE WE STILL HAVE CONCERNS AT A VARIETY 

25 OF AREAS WITH THE FACT THAT, AND I JUST GOT A REPORT LAST WEEK 
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1 IN ONE THAT A INDIVIDUAL WENT WITH THEIR FATHER, WHO WAS IN 

2 SERIOUS SHAPE, AND WAS ASKED AT ONE PARTICULAR LOCATION IF 

3 THAT INDIVIDUAL WHO WAS LATINO WOULD TRANSLATE FOR ANOTHER 

4 PATIENT THAT WAS THERE, AND THE PERSON'S FATHER WAS DYING. SO, 

5 TO ME, I'M NOT GOING BRING UP THE AREA, THIS IS NOT POLITICAL, 

6 IT'S JUST SOMETHING YOU SHOULD THINK ABOUT AND IT'S VERY 

7 SERIOUS TO US AND WE WOULD LIKE TO WORK WITH THE C.A.O.'S 

8 OFFICE AND HUMAN RESOURCES ON DEVELOPING EFFECTIVE PLANS AND 

9 STRATEGIES TO DO THAT, AND MY RECOMMENDATION WOULD BE THAT 

10 ONE, YOU DO THIS, BUT YOU REALIZE THE SHORTCOMINGS AND THAT 

11 YOU STILL HAVE A TITLE 6 OBLIGATION IN ORDER TO EFFECTIVELY 

12 MEET THE NEEDS OF THE COMMUNITY AND TO BE ABLE TO GIVE THEM 

13 THE SERVICES THAT EVERYBODY ELSE BASICALLY THAT COMPLIES WITH 

14 THE LAW AND DESERVES THE SERVICES GETS. THAT'S MY COMMENT. 

15

16 SUP. BURKE, CHAIR: ARE THERE ANY QUESTIONS? THANK YOU VERY 

17 MUCH. WE UNDERSTAND CERTAINLY THAT WE WANT TO EXPAND IT TO 

18 OTHER LANGUAGES, TOO. 

19

20 SUP. ANTONOVICH: A QUESTION. HAVE WE ALREADY PAY A BILINGUAL 

21 PAY SCALE, MR. JANSSEN, FOR FLUENCY IN A SECOND LANGUAGE? 

22

23 C.A.O. JANSSEN: YES, I BELIEVE WE DO, SUPERVISOR. 

24
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1 SUP. ANTONOVICH: AND WOULD THIS HAVE TO BE NEGOTIATED WITH THE 

2 UNIONS? 

3

4 C.A.O. JANSSEN: I'M GOING TO DEFER TO MR. HENRY ON THAT. 

5

6 MR. HENRY: MADAM CHAIRMAN, MEMBERS OF THE BOARD, THE PILOT 

7 THAT WE'RE ENVISIONING PUTTING TOGETHER, WE DON'T BELIEVE 

8 WOULD REQUIRE ANY KIND OF NEGOTIATION WITH THE UNIONS, AND IN 

9 PUTTING THE PILOT TOGETHER, WE CERTAINLY WOULD WORK WITH THE 

10 C.A.O. EMPLOYEE RELATIONS UNION TO MAKE SURE THAT THAT WAS NOT 

11 A PROBLEM. 

12

13 SUP. ANTONOVICH: AND WHEN WOULD THE TRAINING TAKE PLACE? 

14

15 MR. HENRY: WE BASICALLY HAVE TO DEVELOP THE PILOT FIRST, WHICH 

16 HASN'T BEEN DONE. IF THIS MOTION IS APPROVED BY YOUR BOARD, WE 

17 WOULD THEN MOVE OUT TO DO THAT, AND WE PROBABLY COULD HAVE A 

18 PILOT TOGETHER WITHIN THE NEXT 30 TO 60 DAYS. 

19

20 SUP. ANTONOVICH: WHY WOULDN'T YOU HAVE AN ADULT HIGH SCHOOL OR 

21 A COMMUNITY COLLEGE OFFER AN IN-SERVICE PROGRAM AS WE 

22 CURRENTLY HAVE IN-SERVICE PROGRAMS AND CREDIT PROGRAMS OFFERED 

23 ON COUNTY SITES? 

24
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1 MR. HENRY: THAT'S A VERY VALID QUESTION, AND THAT IS ONE OF 

2 THE AREAS THAT WE WILL RESEARCH WHEN WE PUT THE PILOT 

3 TOGETHER. COMMUNITY COLLEGES DO PROVIDE LEVELS OF FOREIGN 

4 LANGUAGE TYPE TRAINING AND THAT'S ONE AVENUE WE WOULD LIKE 

5 TOWARD. 

6

7 SUP. ANTONOVICH: WHAT'S THE COST OR WHAT DO YOU ANTICIPATE THE 

8 COST TO BE? 

9

10 MR. HENRY: WE DON'T KNOW. WE'RE GOING TO TRY AND KEEP THE COST 

11 AS MINIMAL AS POSSIBLE. WE MAY HAVE TO REQUIRE THE EMPLOYEE TO 

12 PAY FOR THIS AFTER HOURS. WE'RE NOT SURE YET. I MEAN, THERE 

13 ARE A LOT OF ELEMENTS THAT WE HAVE TO PULL TOGETHER TO BRING 

14 THIS PROGRAM TOGETHER. 

15

16 SUP. ANTONOVICH: THOSE ARE MY QUESTIONS, MADAM CHAIR. 

17

18 SUP. BURKE, CHAIR: ALL RIGHT. ANY OTHER QUESTIONS? IS THERE A 

19 MOTION? MOVED BY KNABE, SECONDED BY ANTONOVICH. WITHOUT 

20 OBJECTION, SO ORDERED. 

21

22 ALAN CLAYTON: THANK YOU VERY MUCH. 

23

24 SUP. BURKE, CHAIR: PUBLIC COMMENT? I'D LIKE TO ASK THE COUNTY 

25 COUNSEL TO REVIEW ONE OF THE REQUESTS. NAEEMAH GHAFUR, DR. 
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1 GHAFUR. DR. GHAFUR IS NOT ANSWERING. ALL RIGHT, I THINK 

2 MERRITT HOLLOWAY ALREADY ADDRESSED THE BOARD. MERRITT 

3 HOLLOWAY? I DON'T -- HE'S NOT HERE. ALL RIGHT. WOULD YOU 

4 ANNOUNCE... 

5

6 CLERK VARONA-LUKENS: IN ACCORDANCE WITH BROWN ACT 

7 REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF 

8 SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEMS 

9 CS-1 AND CS-2, CONFERENCES WITH LEGAL COUNSEL REGARDING 

10 EXISTING LITIGATION, AND ITEM CS-3, CONFERENCE WITH LEGAL 

11 COUNSEL REGARDING INITIATION OF LITIGATION, ONE CASE, AS 

12 INDICATED ON THE POSTED AGENDA. THANK YOU. 

13

14

15

16

17

18

19

20

21

22

23

24

25
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1

2

3

4

5

6 [REPORT OF ACTION TAKEN IN CLOSED SESSION,

7 WEDNESDAY, NOVEMBER 12, 2003.]

8

9 There is no reportable action as a result of the Board of 

10 Supervisors' closed session held today. 

11
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